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To modify entries for local use on your machine, you need to copy them from
the system and network databases into your private database. To copy an entry
to your database, first scroll through the list of Binder entries in the Binder
base window until you see the one you want to modify.

1. Click SELECT on the Binder entry you want to modify.
A rectangle appears around the chosen entry. The example in Figure 16-2 is
the icon for the Mail Tool application.

! Binder T

(Save) (Wiew v )¢ vy (Props v)

Binder Entries

lotus—spreadsheet

mail—file

PATAN

mail-message i
g

mailtool—prog

0

{New ) (Duplicate ) { £ ists

L Read-Only Entry T

Figure 16-2 Choosing the Mail Tool Icon Entry

2. Click SELECT on the Duplicate button.
The entry is copied into your private database.

3. Choose View » Personal Entries.
The view changes to your personal database, listing the newly copied entry
and any others that you may have. The copied entry has the temporary
name unnamed_1.

Figure 16-3 shows a private Binder database with the newly copied entry.

Binder 455



16

Binder Properties

456

Ir@ Binder - edited T
{Save ) (View v ) Undo) (Props v)
Binder Entries — Personal
|
calctool—prog
B =
% : cat—prog
unnamed_1
—
((New ) (Duplicate’) (Delete)
L ]

Figure 16-3 Private Binder Database

Note - If you run Binder as root without the ~system or -network command-
line options listed above, you will only be able to modify the personal Binder
entries for user “root.” Make sure to use the command-line options if you want
to modify the system or network entries.

When you want to modify or add new bindings, use the Props menu or the
Props keyboard key to display the Properties window. You fill in or change the
information on these properties windows to specify your bindings.

There are two categories of Binder properties: Icon properties and File Type
properties. These categories are described in the following sections.
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The Apply and Reset buttons at the bottom of the Properties window apply or
reset the changes made to both categories, Icon and File Type, at the same time.
If you want to make both Icon and File Type changes, you only need to click

SELECT on Apply once, after you have finished making both sets of changes.

Icon Properties

The Icon Properties window displays all the information used by DeskSet
applications to display and operate on files. The icon properties determine how
files of a particular type are displayed by DeskSet applications (such as File
Manager), and what happens when files of that type are opened or printed.

You display the Icon Properties window by selecting an entry in the base
window scrolling list and choosing Icon from the Props menu. The default Icon
Properties window shows only the information needed to display a type of
files, as shown in Figure 16-4.

© Binder: Properties

Category: File Types

fcon: @ GUIDE—file,

Image File: [€]ILfile_glyph.icon

Mask File: [4]e_glyph_maskicon

Foregr Color: . 000

225 137 206

@
&)

Figure 16-4 Default Icon Properties Window
You can click SELECT on the plus sign (+) button at the lower right of the

window to expand the window to display the full set of properties, including
information needed to open and print a class of files, as shown in Figure 16-5.
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Q Binder: Properties

Category: File Types

2
Icon: ‘&l GUIDE—filg, Application: (€] $FILE done ****; echo
Image File: [¢] ILfile_glyph.icon print Method: cat $FILE | mp —lo| Ipr —h

Mask File: [€)e_glyph_mask.icon

Foregr Color: ] 000

0h0

Backgr Color: [} 229 137 208

Figure 16-5 Expanded Icon Properties Window

You can shrink the window back down to the smaller size by clicking SELECT
on the minus sign (-) button at the bottom of the expanded window.

This section describes the fields in the expanded Icon Properties window.

Icon and Binder Entry Name

The Icon field shows the current icon and Binder database entry name. Use the
text field to modify the entry name, and use the following fields to modify the
appearance of the icon. Double-click SELECT on the temporary unique name to
the right of the icon to modify the icon.

Image File

The Image File text field displays the path of the 32 by 32 pixel (XView format)
icon that is bound to the current Binder entry. The icon is displayed in the base
window scrolling list and the Icon field. This is the same icon displayed by the
File Manager, Mail Tool, and other applications in the DeskSet environment.
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Mask File

The Mask File text field displays the path of an icon color mask. A color mask
defines the region of the icon to which the background color is applied. You
can think of this as a stencil cut out overlaid on top of your icon before the
background color is applied to the icon. If no icon mask file is specified, the
entire icon is colored with the background color.

The icon mask does not have to be a 32 by 32 (XView format) pixel icon. If it is
larger, only the first 32 by 32 (XView format) pixels in the top left corner of the
icon are used.

For example, Figure 16-6 shows the icon and the icon mask for the
printtool-prog Binder entry. The image on the left is the icon image, and
determines what is outlined in the foreground color. The image on the right is
the icon mask, and determines the area of the icon colored with the
background color.

Figure 16-6 The printtool-prog Icon and printtool-prog Icon Mask

Image File and Mask File Line

These text lines specify the path (directory location) to the icon and the icon’s
mask—a stencil of the image that determines the area of the icon colored with
the background color. To modify the current icon in its appearance on the
workspace, do not modify these paths.

Foregr (Foreground) Color

The foreground color is the color that the icon itself is drawn (icon outline)
within the File Manager and other DeskSet applications. If no value is given
for this field, the foreground color is black.
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If you want to pick a new foreground color, click SELECT on the window
button to the right of the Foregr Color text field to invoke the Color Chooser
application. See “Using the Color Chooser Palette with Binder” on page 473 for
more information.

Alternatively, you can type three numbers in the Foregr Color text field to
indicate the amount each of red, green, and blue in the foreground color. Color
saturation values range from 0 through 255. For example, 255 0 0 represents a
bright, solid red color.

Backgr (Background) Color

The background color is the color the icon is colored within (the lines of the
icon) the File Manager and other DeskSet applications. If no value is given for
this field, the background color is white.

If you want to pick a new background color, click SELECT on the button to the
right of the Backgr Color text field to invoke the Color Chooser. See the section
“Using the Color Chooser Palette with Binder” on page 473 for more
information.

Alternatively, you can type three numbers in the Backgr Color text field to
indicate the amount of red, green, and blue, respectively, of the background
color. Color saturation values range from 0 through 255. For example, 0 255 0
represents a bright, solid green color.

Application

The Application text field defines the application that is invoked whenever any
file defined by the current binding is opened in File Manager or other
applications in the DeskSet environment. This text field is on the expanded
portion of the Icon Properties window.

Note - If there is a ToolTalk™ method available, applications do not use this
field. Refer to the Solaris 2.2 Desktop Integration Guide.
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Print Method

The Print Method defines how a file is printed in the DeskSet environment. If
no Print Method is specified, the default print method of the application the
file is being printed from is used. This field is on the expanded portion of the
Icon Properties window.

File Type Properties

You use the File Type Properties window to define the set of files that are
bound to the icon, colors, and applications defined in the Icon Properties
window.

You display the File Type properties by choosing File Types from the Props
menu or the Category choice on the Properties window. The default File Type
Properties window is shown in Figure 16-7.

© Binder: Properties

Category: File Types

i

T [«] New )
u ERILY AN ;
=

Pattern: @

@D @D O

Figure 16-7 Default File Type Properties window
You can click SELECT on the plus sign (+) button to expand the window to

display the full set of properties, including information needed to identify a
class of files, as shown in Figure 16-8.
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Q Binder: Properties

Category: File Types

*G

Identify: | by Name | by ContentJ

Tag Gifset

Tag Yypa

Tag Yalus:

Tag Mask

Pattern: ,

Figure 16-8 Expanded File Type Properties window

You can shrink the window back down to the smaller size by clicking SELECT
on the minus sign (-) button at the bottom of the expanded window.

This section describes the fields in the File Type Properties window.

File Type Scrolling List

Each entry in the File Type scrolling list defines how a file, or a group of files,
is recognized by DeskSet applications. You can think of each entry in the File
Type scrolling list as a class of files, which may consist of one file or many files.
Each class of files in this scrolling list (each File Type entry) is bound to the
Icon properties of the current Binder entry.

Note - If you have two identical File Type entries in your Binder database,
only the first one that the Binder reads is used. The first Binder entry to use the
File Type entry is not necessarily the first Binder entry in the Binder base
window scrolling list.
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Pattern Text Field

Use the Pattern text field beneath the scrolling list to modify the name of a File
Type entry. If the files are to be identified by a pattern, this pattern must be the
name of the Binding entry. If the currently selected File Type is identified by
Content, the Pattern text field is dimmed and unavailable.

When there are no items selected on the scrolling list, you can type a pattern
into the Pattern text field and press Return to create a new File Type entry.

File Type Properties Window Buttons

You SELECT the buttons to the right of the File Type scrolling list to create and
delete File Type entries, and to move them to and from a clipboard, as follows:

® New creates a new File Type entry. The name of the first new entry is
unnamed_1. If you create another new entry without renaming the first, it is
called unnamed_2, etc.

To change the name of a File Type entry, type a new name in the Pattern text
field and press Return. If you want to identify a set of files by a pattern, you
must type the actual pattern in the Pattern text field. If you want to identify
a set of files by content, the name of the File Type entry can be anything.

® Cut removes the currently selected File Type entry from the current Binder
entry (the entry selected in the base window scrolling list), and to move it to
the clipboard. If the current Binder entry is a read-only entry, the Cut button
is inactive.

® Copy copies the currently selected File Type entry to the clipboard.

® Paste adds the File Type entry that is on the clipboard to the current Binder
entry. The Paste button is inactive if there is nothing on the clipboard.

® Delete removes the File Type entry from the current Binder entry. The Delete
button is inactive if the current Binder entry is a read-only entry. Note that
deleting a Binder entry does not delete its File Type entry.

You use the Apply and Reset buttons at the bottom of the File Type Properties
window to apply your File Type and Icon Properties changes to the current
Binder entry, or to reset all the changes you’ve made since the last Apply.
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Identify Choice Item

The Identify choice item determines how the current class of files (the selected
File Type entry) is recognized by DeskSet applications, such as the File
Manager. A class of files is recognized either by Name or by Content, as
defined in the following sections:

Identify By Name

If the Identify choice is by Name, files are recognized by the pattern in the
Pattern text field. In this case, the Pattern is often the name of an application.
For example, Figure 16-9 shows the clock File Type entry that is bound to the
clock-prog Binder entry. Any file called clock will be displayed by the File
Manager with the clock icon and colors displayed in the base window scrolling
list. (The icon and colors are defined by the clock-prog Icon properties.)

r Binder

R L Binder: Properties

(Save)y (View v) ¢ Unis 3 (Props v) Category:

Binder Entries

@ clock—prog
cm~prog
cmdtool—prog
=

® colerchooser
@ compose—prog

[clock ]

Identify: I by Nanlﬂ by Content

Tag Gifyets 3 lale

Fag Yyper | §

Tag ¥alus:

Tag dtasks

= Pattern: clock,

{New ) (Duplicate ) {

L Read-Only Entry |

Read—-Only Entry

Figure 16-9 Clock File Type Entry

When the Identify choice is “by Name” and the Pattern text field contains an
asterisk (*), the asterisk in the Pattern means “match any file name here.” For
example, the File Type Entry *.ps, shown in Figure 16-10, matches all files that
end with.ps. These files are PostScript files, and are displayed in the DeskSet
with the postscript-file icon displayed in the Binder base window
scrolling list.
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" ®) Binder l" < Binder: Properties
(Save ) (Wiew v) ¢ &inids 3 (Props v) Category: | Icon | File Types |

Binder Entries

@ perfmeter—prog

5 | identify: [ by Name | by Content

/Y postscript—file
Ed

| Content Tag Offset

% printtool—prog
readme—file
shell-script
e

Tag Type:

Tag Valup:

Tag dask

= Pattern: *ps,

N

- Read—Only Entry

Sl

Read-Only Entry

| I—

Figure 16-10 The * .ps File Type Entry

An exception to the rule about matching the pattern with the file name occurs
with the Binder entries default-app, default-dir, and default-doc. The
File Manager application uses these entries to determine the bindings for its
default application files, directories (folders), and documents. The File Type
patterns for these bindings are default | app, default |dir, and

default | doc. You will never, however, actually find a file called

default lapp, default |dir, or default |doc. See “Changing a Binding” on
page 471 for information about how to change these default File Manager
bindings.

Identify by Content

If the Identify choice is by Content, files are recognized by matching file
contents instead of the file name. When you choose by Content, the four fields
underneath the Identify setting become active. These fields define what the file
contents should be to define files of the current File Type, as follows:

® Tag Offset determines the starting position in the file (counting from 0)
where the contents should be matched. The default value is 0, meaning
“match the contents starting at the very first character of the file.” A Byte
Offset of 1 would start matching the contents at the second character of the
file, and so on.
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¢ Tag Type determines the type of value that is to be matched in the file
contents: Byte, Short, Long, or String. Most files are ASCII files consisting of
the String data type (that is, words and characters that you can type). A Byte
type is a one-byte numerical value, a Short is a two-byte numerical value,
and a Long is a four-byte numerical value.

® Tag Value determines what to look for in the file contents. This value must
be of the type defined in the Tag Type setting.

¢ Tag Mask is an optional field that you can use to define a mask value for
Byte, Short, or Long data types. If a mask value is defined, a logical AND
operation is performed on the Tag Value and the Tag Mask to determine the
match value (the contents to be matched). This field is primarily intended
for programmers developing applications to be integrated into the DeskSet
environment.

See the magic manual page for advanced information about the Tag Type, Tag
Mask, and Tag Value fields.

'”

Figure 16-11 shows that PostScript files can be recognized by the string “%!” at
the beginning of the file (Tag Offset = 0, Tag Type = String, Tag Value =%!).
Note that PostScript files can also be recognized by files ending with.ps, as
described previously in the section “Identify By Name.”

(=) Binder

19} Binder: Properties

(Save)) (View v )¢ irds; (Props v) Category:

Binder Entries

A—5 perfmeter—pro
g‘t prog

*ps Identify: I by Name Lby Content I

/7 postscript—file
[

[Content L]

% printtool—prog
readme~file
shell—script
ST

Tag Type: | Byte Short
Long String

Tag value: %!

Tag Mask:

- Read-Only Entry r

oo

Read-Only Entry

466

Figure 16-11 The postscript-file Content File Type Entry
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Figure 16-12 shows the sun-raster File Type entry. This class of files is
defined as all files starting with the Long value 0x59a66a95.

(@) Binder bl © Rinder: Properties
(Save) (View v)¢ Category:

Binder Entries

shelltool-prog
fe=

@ snapshot—prog
@ sun—executable

=
[Content | E

sun-raster

sun—icon—image

[ CTI e

PRUREH s,

h Read-Only Entry |

Identify: | by Name [ by Content I
Tag Offset: 0 (a]=}

Short
String

Tag Type: | Byte

Ltong

Tag Value: 0x59a66a35

Tag Mask:

©

Read—Only Entry

Figure 16-12 The sun-raster File Type Entry

Creating a New Binding

The following steps explain how to create a new binding. The example binds
the cat icon described in Chapter 15, “Icon Editor” to the cat program file in

your /bin directory.

1. If an icon does not exist for the new binding, use the Icon Editor to create
a 32 by 32 (XView format) pixel icon.
See Chapter 15, “Icon Editor” for instructions.

The icon for the binding is the icon displayed by the File Manager, Mail
Tool, and other applications in the DeskSet environment

If you want to color only part of the icon when it is displayed in the File
Manager or other DeskSet applications, use the Icon Editor to create a 32 by
32 (XView format) pixel icon mask, which defines the area of the icon to be
colored. See “Mask File” on page 459 for information about icon masks.

Binder
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2.

Click SELECT on the New button at the bottom of the base window.

A new entry is automatically created called unnamed_1, and the Binder
Properties window is displayed showing the Icon category, as shown in
Figure 16-13. If an entry called unnamed_1 already exists, the new entry is
called unnamed_ 2, and so forth.

G Binder — edited

RS

Binder: Properties

(View v) (Undo) (Props v)

Category: File Types

Binder Entries

% textedit-prog
® window—prog
xpm-—file

Icon: D unnamed_1,

Image File: (€] c_Doc_glyph.icon

Application: textedit

Print Method:

Mask File: [€]glyph_mask.icon

Foregr Color: . 000

j unnamed_1

&
@

Backgr Color: ] 229 91 193

[ I Y |

]

Figure 16-13 A New Binder Entry

3.

Replace the name in the Icon text field of the Properties window with the
name you want for the new Binder entry.
In this example, type cat_prog in the Icon text field.

. Type the path and file name of a 32 by 32 (XView format) pixel icon in the

Image File text field.
In this example, type the path and name of the cat icon created in Step 1.

If you want to specify a color mask for the icon, type the path and file
name of the icon mask in the Mask File text field.

An icon mask defines the area of the icon to be colored when the icon is
displayed in the File Manager or other DeskSet applications. See the section
“Mask File” on page 459 for more information.

If you don't specify an icon mask file, the entire icon image will be colored
with the background color.
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6. Specify the foreground and background colors for the icon by typing RGB
(red/green/blue) values in the text fields, or by using the Color Chooser.
The foreground color is the color the icon is drawn with when it is
displayed by the File Manager or other DeskSet applications. See the section
“Foregr (Foreground) Color” on page 459 for more information.

The background color is the color the icon is filled with when it is displayed
by the File Manager or other DeskSet applications. If you have specified an
icon mask file, the background color is only filled in the mask area. See the
section “Backgr (Background) Color” on page 460 for more information.

You use the Color Chooser to specify colors by clicking SELECT on the
Foreground Color or Background Color menu buttons, located to the right
of the Foregr and Backgr text fields. See “Using the Color Chooser Palette
with Binder” on page 473 for information about using the Color Chooser.

7. If desired, type an Application or Print Method, or both, in the text fields
of the expanded Properties window.
If your Properties window is not expanded, click SELECT on the plus sign
(+) button at the bottom right corner of the Properties window to display
the Application and Print Method text fields.

The Application defines the application that is invoked whenever any file
bound to this set of properties is opened in File Manager, Mail Tool, or other
applications in the DeskSet environment. The default application is
textedit.

The Print Method defines how a file bound to this set of properties is
printed in the DeskSet environment. If you do not specify a Print Method,
the print method of the application the file is being printed from is used.

8. Choose File Types on the Properties window Category choice item to
display the File Type properties.
The File Type properties determine the set of files that are bound to the Icon
properties that you just specified.
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9.

10.

11.

12.

13.

Type the new File Type entry name in the Pattern text field and press
Return.
In this example, type cat in the Pattern text field.

If you are going to recognize files by Pattern, the Pattern text field must
contain the pattern to be matched, such as cat in this example. If you are
going to recognize files by Content, the Pattern text field can be anything
that distinguishes this type of file.

Move the pointer to the Identify choice item on the expanded properties
window, and click SELECT on “by Name” or “by Content” to specify how
you want to recognize files.

In this example, click SELECT on “by Name” to match the file named cat.

If you select “by Content,” the last four Type Information fields become
active. You then need to specify the Tag Offset, Tag Type, and Tag Value to
be used to recognize files by content. You can also specify a Tag Mask, if
desired. See the section “Identify by Content” on page 465 for more
information about the Content fields.

If you want to specify more files to be bound to the Icon properties, repeat
steps 9 and 10.

Click SELECT on the Apply button to apply the Icon and File Type
properties to your new Binder entry.

Click SELECT on the Save button at the top of the Binder base window to
save the new Binder entry in your personal database.

If you are running the Binder as root with the special options to update the
system or network entries, the new entry is added to the appropriate
database. See the section “Binder Databases” on page 453 for information
about the three different Binder databases.

Note — The DeskSet applications will not recognize the new binding until you
have saved it by clicking SELECT on the Save button. You must also restart the
application.

Figure 16-14 shows the new bound image after quitting File Manager and
starting it again.
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Figure 16-14 The New Image in the File Manager

Deleting a Binder Entry

Changing a Binding

To delete a Binder entry, select the entry in the Binder base window scrolling
list, and click SELECT on the Delete button. Then click SELECT on the Save
button. The Delete button is dimmed and inactive if the currently selected
entry is a read-only entry.

Note — When you delete a Binder entry, the File Type entry associated with it is
not deleted. If you want to delete the File Type entry, make sure to delete it
from the File Type scrolling list before you delete the Binder entry.

To delete the File Type entry, select the Binder entry in the base window
scrolling list, display the File Type Properties window, select the File Type in
the File Types scrolling list, and click SELECT on the Properties window Delete
button.

To change a binding:
1. Select the entry in the Binder base window scrolling list.

2. Modify the Icon and File Type properties fields that you want to change.
Make sure to click SELECT on the Apply and Save buttons to apply your
Properties changes and then save them to the Binder database.
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If the binding that you want to change is a read-only entry, you can select the
entry and then click SELECT on the Duplicate button to make a private copy of
the entry. You can then modify your private copy of the Binder entry.

For example, suppose you want to change the color that File Manager uses to
display folders. Follow these steps:

1.

Select the entry default-dir in the Binder base window scrolling list.
The footer message in the bottom right corner of the Binder indicates that
this is a read-only entry.

. Click SELECT on the Duplicate button to copy the entry to your user

database.

A new Binder entry is created called unnamed_1, with all the same Icon
properties as the original default-dir Binder entry. You can modify this
new user entry.

. Rename the new Binder entry default-dir.

This will put an entry called default-dir in your personal user Binder
database. This personal entry will override the System or Network entry of
the same name.

Note — If you later create a second user entry called default-dir, only the
entry created first will be recognized.

4.

Change the background color to the new desired color.

You can either type in new RGB (red/green/blue) values in the Backgr
Color text field, or click SELECT on the Backgr Color window button to
display the Color Chooser. See the sections “Backgr (Background) Color” on
page 460 and “Using the Color Chooser Palette with Binder” on page 473 for
more information.

Click SELECT on the Apply button.
This updates the Icon name and color in the new Binder entry.

Click SELECT on the Save button.
This updates your database to include the new Binder entry.

Now when you view the merged Binder databases (the All option of the
View menu), your user entry will replace the System or Network entry of
the same name. If you want to use the System or Network entry again,
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simply delete the User entry. The next time you start a new File Manager
application, the color specified in your new user Entry will be used to
display folders.

Using the Color Chooser Palette with Binder

You can use the Color Chooser with the Binder to specify foreground and
background colors for the icons displayed by the File Manager or other
DeskSet applications.

To use the Color Chooser to select Foreground or Background icon colors, click
SELECT on the Foregr Color or Backgr Color menu button. (These are the
buttons to the right of the text fields.) The Color Chooser is then displayed, as
shown in Figure 16-15.

& Color Chooser

| ]

DESSEBan
BRERE RSB

i

pn
1)
wn
2]
—+

Choosing Foreground Coler for Binder

Figure 16-15 Color Chooser for Binder’s Foreground Color

The icon image with the current Foreground and Background colors is
displayed in the upper left corner of the palette shown in Figure 16-15 above.

To use a color displayed in the Color Chooser palette:
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1. Click SELECT on the desired color in the Color Chooser palette.
The selected color is highlighted and displayed in the Color Chooser
preview area. The preview area is the large square at the left of the palette.

2. Click SELECT on the Apply button to record the color change.
The square in the top left corner of the palette changes to the newly selected
color.
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Customizing the Solaris
Environment V=

You can customize many aspects of the Workspace environment to suit your
needs. For instance, you can use the Workspace Properties window to change
the colors of the Workspace and windows, and modify the location of the
window scrollbars and how the mouse buttons and pointer behave. This
chapter discusses these and other methods of customizing your OpenWindows
environment.

Viewing Information About Your Workstation

As things change within your operating environment, or if changes are made
to your system, you may be asked for certain basic information about your
system. This information can also be helpful to a system administrator if you
are having system problems.

Some basic information about your workstation can be found on the
Workstation Information window, shown in Figure 17-1.

4 To open the Workspace Information window, choose
Workspace» Workstation Info.
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Workstation Name: river
workstation Type: Sun 4/50 (SPARCstation IPX)

Host ID: 57211b35
Internet Address: 129.144.152.245
Network Domain; DGDO.Eng.Sun.COM

Physical Memory (RAM): 32 Megabytes
Virtual Memory (Swap): 143 Megabytes

Virtual Memory In Use: qi_n_'l_—'l_rr;-“_.j percent
0 100

Operating System: SunOS Release 5.1
window System: Openwindows Version 3.2

Figure 17-1 Workstation Information Window

Basic information available to you from the Workstation Information window
is as follows:

Your Workstation Information

The following information tells you the name and type of workstation you
have or are using.

Workstation Name

This is also known as the machine name or host name. It is the unique name you
or your system administrator gave to the machine you are using. This is
usually not the same name as your user name or login name. This is the
machine name that other users see over the network, such as from electronic
mail.
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Workstation Type

This is usually the product name (or type) for your workstation. It may reflect
the model number of the workstation.

Networking Information

These three items provide some networking information.

HostID

A unique CPU number assigned to your machine. This is sometimes used for
licensing software.

Internet Address

Your unique machine address that allows other machines to talk to your
machine over the network.

Network Domain

Name of the (NIS) domain to which your machine belongs. Contains password
information and other network machine addresses.

System Memory Information

These three items provide some simple information on how the system is using
memory.

Physical Memory (RAM)
This tells you how much Random Access Memory (RAM) is installed.

Virtual Memory (Swap)

The amount of swap space on the hard disk.
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Virtual Memory In Use

If the number on the slide bar gets close to 100%, contact a System
Administrator for adjustment.

Solaris 2.2 Information

These two items tell you version and release numbers with the Solaris 2.2
release.

Operating System

The version and release number of the operating system your workstation is
running.

Window System

The name and version number of the window system that your workstation is
running.

Using the Workspace Properties Window

478

Here is an overview of the Workspace Properties window categories. They are
discussed in detail in this chapter. Depending on the hardware capabilities of
your display, the Workspace Properties window categories may have different
choices available to you.

¢ Color allows you to change the foreground and background color of
windows, data areas, and the Workspace.

¢ Font allows you to choose the style and scale (size) of text in window titles,
menus, buttons, and other system elements.

¢ Keyboard allows you to turn on or off the clicking of keys, repetition of a
character when its key remains pressed, and keyboard equivalents of mouse
actions.

® Mouse allows you to control mouse behavior in relation to pointer speed,
movement, and placement; multiple click intervals; and button order for
right- and left-handed users.
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® Menu allows you to specify how quickly a submenu is displayed based on
how far the mouse is dragged to the right. Some menu characteristics are
determined by mouse actions. You can also choose whether to display the
default item when you click SELECT on a menu button or to carry out the
default command without displaying the menu.

® Programs menu allows ydu to rearrange items on the Programs menu
(displayed by choosing Programs from the Workspace menu). You can also
add and delete items.

® Miscellaneous category has several settings:

* Screen saver protects your screen life when the computer is not in use. You
can turn it on or off, and set the timeout.

* Beeping alerts you to various conditions. You can turn it on or off, or turn
it on for notices only.

* Set Active window selection allows you to activate a window either by
moving the pointer into the window or by clicking in the desired window.
Only one window can be active at a time.

* Icon and scrollbar allow you to choose where to place icons and scrollbars.

® Locale allows you to select settings appropriate for your language and
cultural notation.

All of these items can be set through the Workspace Properties window.

1. To open the Workspace Properties window, choose Workspace »
Properties.

Depending on the hardware capabilities of your display, the Workspace
Properties window categories may have different choices available to you. You
choose the category you want to change from the Category menu.

2. To view the Category menu, position the pointer on the Category menu
button and press MENU.

Figure 17-2 shows the Category menu.
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Workspace Properties

Category: Color Reset To Standard

olor
WINDOWS Fonts

Keyhoard
Mouse

Menus
Programs Menu
Miscellaneous
Locale

DATA AREAY

Background: @ {:}

WORKSPACE

Foreground: @' Pattern:
Background: @ m

Window Title

Control Area

Data Area

Figure 17-2 Category Menu

Change Bars

As you change settings, a vertical change bar is displayed to the left of the
setting you have altered since the last time changes were implemented. This
visual cue helps you track your changes.
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Workspace Properties Window Buttons

Setting Colors

The Workspace Properties window has three buttons:

® Reset to Standard displays (but does not implement) the system default
settings—that is, the settings determined by your system administrator.
Change bars mark your previously-applied nonstandard settings.

® Reset ignores any changes and immediately reverts to previously-applied
settings.

® Apply implements changes. Most changes take place immediately, while
others do not take place until you open a new application or restart the
OpenWindows software.

Note - To change settings in more than one category, be sure to select Apply
before continuing to the next category. Unlike previous versions, this version of
OpenWindows software treats changes to each category separately.

Depending on the hardware capabilities of your display, the Workspace
Properties window categories may have different choices available to you.
When you open the Workspace Properties window, color appears as the first
property you can customize. Figure 17-3 shows the Color category in the
Workspace Properties window.
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Workspace Properties

category: [¥) Color Reset To Standard

]

© Window Foreground Color
WINDOWS LJCIIC I
BBEEEE S8
foreground: () [l LI oI
faseaeaas
sackground: ([ ] OOCnocrcicd
DATA AREAS 8 ]
Foreground: @‘

Background: @E} [ Palette T Custom | ”

WORKSPACE

Foreground: @' Patterr:
Background: @Eﬁ:}

Window Title

Cantrol Area

Data Area

Figure 17-3 Workspace Color Category

To modify colors:

1. Click SELECT on the button for the item you want to change.
Each button (Windows Foreground, Windows Background, Data Areas
Foreground, and so on) has a corresponding pop-up window that displays a
color palette for that item. Figure 17-3 shows a color palette. (Note that for
the purpose of this document, the color choices have been replaced with
patterns.)

2. Point to a new color on the palette and click SELECT.
The preview area at the bottom of the Workspace Properties window, as
shown in Figure 17-4, shows a sample of your color choices.
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Window Title

Control Area

Data Area

Figure 17-4 Color Preview Area

3. If you are not satisfied with the new color, select another color from the
palette, or create a custom color.
To create a custom color:

a. Click SELECT on Custom on the palette.
The palette is replaced with sliders for Hue, Saturation, and Brightness,
as shown in Figure 17-5. (Note that for the purpose of this document, the
color choices have been replaced with patterns.)
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Workspace Properties

Category: [Z) Color
WINDOWS Hue: 0}

Foreground: @‘

Background: @ {:}

DATA AREAS Brightness: [}

Foreground: @‘
Background: @{:} [ Paleite [ Custom | ~

WORKSPACE ]

Foreground: @' Pattern: (3]
Background: @D

Window Title

©

Window Foreground Color

Control Area

Data Area

Figure 17-5 Using the Custom Color Palette

b. Move the sliders as you watch the preview area.
The sliders let you control three characteristics:

* Hue is a color from a range of colors—red, orange, yellow, green, blue,
indigo, violet and magenta.

* Saturation is the deepness, or richness, of a color.

* Brightness is the amount of light that is filtered into a color.

4. To change additional foreground or background colors, repeat the
previous three steps.
A palette for each foreground and background color is pinned to the
Workspace.
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Customizing Fonts

5. When the colors suit you, click SELECT on Apply.
The changes take place immediately on the Workspace, in the Workspace
menu, and in the window frames of any applications that are already open
on the Workspace. Depending upon your system configuration, application
control areas in open windows remain the previous color until you quit and
restart the application(s).

OpenWindows DeskSet applications are set up with default fonts that appear
on all items, such as icons, menus, and windows. Normally, you do not need to
customize the style or point size of these fonts. However, if you would like to
increase or decrease the size of the default, or if you are partial to a particular
font, it is possible to change the default font style and size for the system font
from the Fonts category.

The following sections on fonts describe two methods of customizing fonts: a
basic method of changing the scale of the font (which also affects the window
scale), and a method of changing the font style, The first method simply
increases or decreases the font size (to small, large, or extra large) and its
window size, while the second provides greater flexibility in defining the style.

Choosing a Font Scale

The scale allows you to choose from four font sizes for windows. You can
change the default so that all applications subsequently open in the size you
specify. Note that when you scale the font, the window scales with it.

You can choose from these four sizes:

® small

®* medium (the default)
® large

® extra large

Note — Not all fonts styles and sizes appear on the screen satisfactorily. If the
size is too large, some items, such as menu buttons, may be obscured.
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Specifying the Font Style

Default fonts include:

®* Windows: Lucida Sans in 12 point (medium)
® Window headers: Lucida Sans Bold
¢ Text subwindows: Lucida Sans Typewriter

If you prefer, you can specify another font style and size.
To select a different typeface:

1. Select a typeface from the scrolling list.
A sample of the typeface is displayed in the preview area. If you are not
satisfied, select another typeface.

2. Click SELECT on Apply.

Listing the Available Fonts

When the Standard selection is chosen, you can scroll through all of the
typefaces installed with OPEN LOOK style, the Custom Selection refers to all
fonts available on your system.

Note - The list generated from x1sfonts is very long; there are over 400 fonts
available. If the listing on your screen does not contain the expected number of
fonts, check with your system administrator. It is possible that a subset of the

available fonts was installed.

Previewing Selected Font Settings

You can look at the selected typeface and scale settings in the Preview box.
This shows you how text appears in:

® Control settings—places like buttons and text fields (scrolling lists) in your
window system.

¢ Control labels—places like captions.

® Data areas—places like text in the Text Editor window.
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Keyboard Menu Equivalents

You can turn on or turn off the keyboard accelerator keys. This means that the
keyboard character of the acceleration shows up in the following:

® Application + Window—means in all applications that use them and in
Open Windows menus

¢ Application Only—means only OPEN LOOK applications that use them
® None—means will not show up in any OPEN LOOK application

This is a standard set of tasks (within a DeskSet application) that can be
“accelerated” from the keyboard by using keyboard shortcuts. These will be
visible from the pull-down menus, and can be configured on or off from the
Workspace Properties menu. Keyboard accelerators are active for only the
windows that are active. If you need to turn these off, you can select None
from Keyboard Menu Equivalents from the Keyboard Properties. The
following table outlines the keyboard shortcuts and their functions.

Customizing the Solaris Environment 487



=17

Table Legend

FM = File Manager CM = Calendar Manager
MT = Mail Tool TE = Text Editor

SS = Snapshot IE = Icon Editor

B = Binder PT = Print Tool

IT = Image Tool AT = Audio Tool

X = Accelerated Menu Item

- = no relevant menu item

btn = relevant item is a button (no accelerator)

meta = use the meta (<>) or similar symbol on your keyboard
Accel = Keys to press in this order to invoke the accelerator

Keyboard Equivalent Menu Items

Accel FM | CM | MT | TE SS IE B PT IT AT
New meta + N X - X - - - - - - X
Open meta + O X X X X btn X - - X X
Save meta + S - - X X btn X btn - X X
Print meta + P X X X - X X - - X -
Find meta + F X X X X - - - - - -
Sel. All meta+ A - - - - - - - - - -
Undo meta + Z - - - X - X - - X X
Redo shift meta - - - - - X - - - X
+Z
Cut meta + X X - X X - X - - - X
Copy meta + C X - X X - X - - - X
Paste meta+ V X - - X - X - - - X
Props meta + 1 X X X - - - X X X X
Typeface | meta+ T - - - - - - - - - -
Normal shift meta - - - - - - - - - -
+N
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Keyboard Equivalent Menu Items

Accel FM |[CM | MT | TE | SS | IE PT | IT | AT
Bold shift meta - - - - - - - - -
+B
Italic shift meta - - - - - - - - -
+1
Other Keyboard Options

A couple of other keyboard options you can control are:
¢ Key Click sounds a click with each depression of a key.

¢ Key Repeat means when a key is depressed and held, the key will type
multiple characters until released. With this setting turned on, a single
character is typed, when it is off, multiple characters are displayed.

Modified Use of the Keyboard and Mouse

This section lists accelerator key commands that you can substitute for mouse
and menu operations. Accelerator keys help you use the interface efficiently by
performing operations that normally require several mouse actions. This is
especially useful to those who prefer the use of the keyboard over the use of
the mouse, but can be helpful to anyone who wants to increase efficiency
through fewer hand movements away from the keyboard.

Keyboard Accelerators

The following sections describe basic editing operations, navigating your way
through files and windows, and opening menus without using the mouse
buttons.

Note - The commands for navigating in text files pertain to the Text Editor
application window.
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Erase Functions

Table 17-1 Commands that Erase Characters, Words, or Lines

Sequence
Backspace
Shift-Backspace
Control-w
Control-Shift-w
Control-u
Control-Shift-u

Move Caret Functions

Action

Erases character to the left of the insert point
Erases character to the right of the insert point
Erases word to the left of the insert point
Erases word to the right of the insert point
Erases to the beginning of the line

Erases to the end of the line

Table 17-2 Commands that Move the Caret Within Text

Sequence

Control-b or Left Arrow
Control-f or Right Arrow
Control-Shift-b

Control-,

Control-.

Control-a

Control-e

Control-p or Up Arrow
Control-n or Down Arrow

Control-Return, End
Control-Shift-Return or Home
Page Up

Page Down
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Action
Moves the caret one character to the left
Moves the caret one character to the right
Moves the caret one word to the right
Moves the caret one word to the left
Moves the caret to the end of the word
Moves the caret to the start of line-
Moves the caret to the end of the line

Moves the caret up one line, maintaining
column position

Moves the caret down one line, maintaining
column position

Moves the caret to the end of text
Moves the caret to beginning of text
Moves caret up one pane

Moves caret down one pane
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Function Keys

The following commands use the keys on the panel to the left of the keyboard,
and are specific to the Type-4 and Type-5 keyboards.

Table 17-3 Function Keys and Their Actions

Sequence Action

Stop, Esc Stops the current operation

Again or Meta-a Repeats the previous operation

Props Displays the property window for the application at
the pointer location

Undo or Meta-u Undoes previous operation

Front Brings the window at the pointer location to the front

of the screen. When the window is already at the
front, moves it to the back of the screen

Copy or Meta-c Copies selection to the clipboard
Open Opens the icon at the pointer location or closes the
’ window at the pointer location
Paste Copies clipboard selection to the insert point
Find or Meta-f Finds selection to the right of the caret
Shift-Find Finds selection to the left of the caret
Cut or Meta-x Cuts selection and puts it on the clipboard
Help Displays a help window with context-sensitive help

for the object at the pointer location

Keyboard Mouse Equivalents

The following keyboard accelerators require that you use mouseless mode. You
can set this from the Properties menu:

1. Select either Basic or All Functions from the Keyboard Mouse Equivalent.

2. Press SELECT on Apply.
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Global Navigation Functions
Table 17-4 Commands for Navigating About the Workspace

Sequence Action

Alt-w Moves focus to the next window within the current
application

Shift-Alt-w Moves focus to the previous window within the
current application

Alt-n Moves focus to the next application

Shift-Alt-n Moves focus to the previous application

Shift-Alt-m Displays Workspace menu

Local Navigation Commands
Table 17-5 Commands that Manipulate Base Windows or Pop-Up Windows

Sequence Action

Alt-m Displays window menu

Alt-F5 Moves window to back

Alt-F6 Enables you to move window with arrow keys
Alt-F7 Enables you to resize window with arrow keys
Alt-F8 Refreshes window

Table 17-6 Commands that Manipulate Base Windows Only

Sequence Action

Alt-F2 Opens the icon at the pointer location or closes the
window at the pointer location

Alt-F3 Resizes window to full size or reduces it to default
size

Alt-F9 Quits application

Table 17-7 Commands that Manipulate Pop-Up Window Menus

Sequence Action
Alt-F2 Dismisses or cancels pop-up menu
Alt-F10 Indicates owner of pop-up menu
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Mouse

You may want to change the way your mouse behaves within the Workspace.

Q Workspace Properties
Category: @ Mouse Reset To Standard
Mouse Acceleration: -Q—:.
1 LI I I I O I I
None High
Mouse Threshold: _D:' |
[N ] [ DJKEIS
1 50

Multi-Click Interval:
LI Tt seconds
1.0

0.1

Mouse Button Order: SELECT-ADJUST-MENU
MENU-ADJUST-SELECT

Pointer Jumping: W scollbars

W Pop-Up Windows

Figure 17-6 Mouse Properties

You can change the following settings from the Mouse Properties:
® Mouse Acceleration is the speed at which the mouse moves.

® Mouse Threshold defines how far (measured in pixels) does the mouse
move before acceleration begins.

® Multi-Click Interval specifies the time, in tenths of a second, that
differentiates a double-click from two single clicks.

Mouse Button Order changes the order of the mouse button functions.

® Pointer Jumping defines a specific way in which the pointer can move in
relation to scrolling a window or a pop-up menu.
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Multi-Click Interval

Use the Multi-click Interval setting to specify how many tenths of a second can
elapse between successive clicks on a mouse button before the first click is
ignored. This affects how quickly you must double-click the SELECT button,
for instance, when you want to open an application window from an icon.

To set the multi-click interval, drag the slider with the pointer. After you make
your changes in the mouse settings window;, click SELECT on the Apply button
to store the new settings.

Depending upon your system configuration, changes to the Scrollbar Pointer
Jumping and Pop-up Pointer Jumping options do not take place in existing
application windows, but in those that you open from the Workspace menu
after the change was applied. The Multi-Click Interval option takes effect
immediately in all applications.

Mouse Button Order

The default positions of the SELECT, ADJUST, and MENU buttons on your
mouse are labeled from left to right. Frequently, a left-handed user prefers to
move SELECT to the third position and move MENU to first position.

Figure 17-7 shows the default functions of the mouse buttons SELECT-
ADJUST-MENU.

SELECT
ADJUST
MENU

Figure 17-7 Functions of the Mouse Buttons for Right-hand Use

Figure 17-8 shows the functions of the mouse buttons after changing the order
to MENU-ADJUST-SELECT.
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ADJUST
SELECT

Figure 17-8 Functions of the Mouse Buttons for Left-hand Use

Now when the right mouse button is pressed, SELECT is activated, and when
the left button is pressed, MENU is activated. Figure 17-8 shows the functions
of the mouse buttons after the remapping. After you make your changes in the
mouse settings window, click SELECT on the Apply button to store the new
settings.

Mouse Pointer Jumping

The Mouse Property contains Pointer Jumping controls for scrollbars and pop-
up windows. Each of these defines a specific way in which the pointer can
move in relation to scrolling in a window or a pop-up menu.

Customizing Scrollbar Pointer Jumping

Use the Pointer Jumping Scrollbar check box to specify whether or not you
want the pointer to move along with the scrollbar elevator during scrolling
actions. When the box is checked, as in Figure 17-6 on page 493, pointer
jumping is enabled.

When the box is not checked, pointer jumping is disabled, and the pointer
remains in a fixed position as the scrollbar elevator moves. Note that if you
position the pointer above or below the elevator and click SELECT several
times, the elevator catches up with the pointer, and you must move the pointer
to continue scrolling in the same direction.
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Customizing Pop-up Pointer Jumping

Use the Pointer Jumping Pop-up check box to specify whether or not you want
the pointer to jump into a pop-up window automatically when it comes up.

If this setting is checked, when a pop-up window with a notice is displayed,
the pointer jumps to the default button (that is, your anticipated choice). For
example, when you choose Exit from the Workspace menu, a notice asks your
to confirm that you want to leave the window system. The notice has two
buttons: Exit and Cancel. The pointer jumps to Cancel when the notice window
is displayed. (The pointer “jumps” so quickly that you see no movement.) In
Figure 17-6 on page 493, this option is on.

When the box is not checked, the pointer does not jump to the default button
in the pop-up window but remains where it was when the pop-up window
appeared. Move the pointer onto the appropriate button and click SELECT.

To turn off the pop-up pointer jumping, click SELECT on the check mark. The
check mark disappears and the option is turned off.

Setting the Drag-Right Distance of Menus

The “drag-right distance” is the distance that you must move the pointer to the
right before a menu is displayed. This distance is measured on the screen in
pixels, or “picture elements,” whose number corresponds to the resolution of
the monitor. To modify the drag-right distance, follow these steps:

1. In the Workspace Properties window, press MENU on the Category menu
button and choose Menus.
Figure 17-9 shows the Menus category defaults.
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©Q workspace Properties
category: (@ Menus
Drag-Right Distance: ——
g g rrrrrrnnn rirn ulxels
o] 150

Left Mouse Press: [Displays Menu
Selects Default Item

Figure 17-9 Menus Category

2. Move the slider to the desired distance.
The distance from the left of the slider is the actual drag-right distance that
will take effect on your screen.

3. Click SELECT on Apply to make the change take effect.

Customizing Menu Operation

The Menus category of the Workspace Properties window also allows you to
change how you operate menus. It determines whether the default menu item
is chosen automatically when you click SELECT on a menu button or the menu
is presented for you to make a choice. With the default setting, Selects Default,
the default menu item is automatically chosen when you click SELECT on the
menu.

The alternate choice, Displays Menu, sets the SELECT button just to display
the menu. You then need to click the SELECT button again to choose a menu
item.
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Programs Menu

Miscellaneous

498

You can add items to your Programs menu, remove items, or change their
order. Follow these steps:

1.

5.

SELECT an item in the list that is adjacent to desired location of the new
item.
This highlights the approximate location of the new item.

Type a name for the item in the Label: field.

Type the full path name to the command or program to be executed in the
Command: field.

SELECT Paste Before or Paste After.
* Paste Before places the new item above the highlighted item.
* Paste After places the new item below the highlighted item.

* If no item is highlighted, the new item is added at the top or bottom of the
list.

SELECT Apply.
The new label for the command is now displayed in the list.

The button functionality is as follows:

Change allows you to change the command or label to associate with label
shown.

Add allows you to add new label/command.
Cut/Copy allows you to cut or copy an item.

Paste Before/Paste After allows you to paste a label /command before or
after a selected label.

Delete allows you to delete label/command.

Make Default allows you to make currently selected item the default item
on the Programs menu.

The following Workspace items can be customized from Miscellaneous:

Screensaver on/off
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Screensaver timeout
When to beep

Beep duration
Focus policy

Icon location
Scrollbar placement

To customize these settings, choose the Miscellaneous category from the
Workspace Properties menu. Figure 17-10 shows the Miscellaneous category.

©Q Workspace Properties
Category: (¥) Miscellaneous Reset To Standard

Screen Saver:

Beep: | &lways |Notices Onlyl Never

Beep Duration: ey milliseconds
0 1000
Set Active Window: [ ClickMouse | Move Pointer |

Icon Location: | Top [ Bottom | Left [ Right |

Scrollbar Placement: | Left I Right |

Figure 17-10 Miscellaneous Category of Workspace Properties

Setting the Screensaver Feature

The screensaver feature makes the screen go blank after a period of no use. This
option is turned off by default, but you can enable it.

To turn on the screensaver:

1. Press SELECT on Auto.
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2. Type the number of minutes before it is enabled. The default is five
minutes.

3. Press SELECT on Apply.
Your changes now apply.

Returning to the Desktop

If you have set the screensaver option and your screen turns blank, you can
restore your desktop by moving the mouse in any direction. Although input
from any keyboard key or mouse button will restore your screen, it is advised
that you move the mouse instead. This is because pressing a key creates system
input. This means, as an example, that if the pointer is positioned in a text file,
you may insert a character in the text.

Setting the System Beep

Use the Beep setting to specify whether your system beeps for all application-
generated beep actions (errors, messages in your Console, and so on), only
when a notice is displayed, or never. Figure 17-10 on page 499 shows the beep
settings. To customize the system beeps, click SELECT on the chosen beep
setting in the Miscellaneous category of the Workspace Properties.

You can move the slider from Beep Duration to increase the length of time the
system beeps.

Setting the Active Window

Use the Set Active Window setting to specify whether you must click SELECT
on the window to change input focus, or whether you simply move the pointer
into the window to specify that window as the active input area. The active
input area is where you enter text, whether in a text pane of a base window or
a text field of a window control area. The two choices, Click Mouse and Move
Pointer, are also called Click-to-Type and Focus-Follow-Pointer. In Figure 17-10
on page 499, the Click Mouse choice is selected.

The default is Click Mouse. The Click Mouse option requires that when you
move the pointer from one window to another, you must click SELECT before
you can type any text into the window.
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If you choose the Move Pointer option, you don’t need to click in the window
to make it active and ready for input. The presence of the pointer within the
boundaries of the window tells the current window that now it is the focus of
the user’s attention.

To change the setting, click SELECT on the setting you prefer.

Setting the Default Locations for Icons

You can change the default location where icons appear in the Workspace
when they are closed from windows. The OpenWindows default location for
icons is on the bottom edge of the Workspace.

To change the default locations of icons:

1. In the Workspace Properties window, press MENU on the Category menu
button and choose Miscellaneous.

2. Click Select on the appropriate button.
You can specify any of the four edges of the Workspace as the default
location for icons.

3. Click SELECT on Apply.
Changes to the Icons setting take effect immediately. That is, icons for any
applications that are subsequently opened are located in the newly specified
location. Icons for applications already on the Workspace remain in their
current locations.

Changing Scrollbar Placement

Use the Scrollbar Placement setting to specify whether scrollbars are displayed
at the right or the left side of the pane. This setting applies to all scrollable
application windows on the Workspace. In Figure 17-10 on page 499 the
default option, Right, is selected.

To set the location of the scrollbars on the left side, click SELECT on the Left
button.

Note - Scrollbar changes do not affect applications that are already on the
Workspace.
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After you make your choices for system beep, input area, and scrollbar
placement, click SELECT on Apply to store the changes. Changes made to the
Miscellaneous category take place immediately after you apply them.
Locale
The Locale category of the Workspace Properties window provides users with
a mechanism for specifying an input language and display language, as well as
time, date, and numeric formats for a specific locale. Figure 17-11 shows the
Locale category in the Workspace Properties window.
19] Workspace Praoperties
Category: Locale
Basic Locale: U.S.A,
Display Locale: English
Input Locale: English
Time Format: (& 12/31/89 21:30:30
Numetic Format: 10,000.0
Figure 17-11 Locale Category in the Workspace Properties Window
If your system has a Solaris localization installed, such as Japanese Solaris,
German Solaris, or French Solaris, you have access to locales in addition to the
basic U.S.A. locale. If you do not have a Solaris localization installed, U.S.A.
(English) is the only available locale. The following is a description of each of
the choices in the Properties window:
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® Basic Locale is the name of the country or native language of the user
interface. Specific setting choices vary depending on the basic locale setting.
® The following settings help define characteristics of a particular locale or
cultural area.
* Display Locale specifies the language in which messages, menu labels,
button labels, help files, and so forth are displayed.
* Input Locale specifies the language to be input.
* Time Format specifies the format for the time and date.
* Numeric Format defines the numeric format or placement of the comma
or decimal point.

Note — For those systems that allow locale specifications, changes apply when
you start a new application. The changes do not affect applications already
running,.

Customizing the Solaris Environment 503



17

504

Solaris 2.2 User’s Guide—May 1993



Refresh

Reset Input

Utilities 18=

In addition to the applications under Programs, the Workspace menu has
several important utilities. This chapter discusses each of the utilities in the
order they appear in the menu.

¢ To use a utility, choose Workspace » Utilities and select a submenu.

Sometimes an application prints characters outside of a particular window, or
leaves artifacts—lines or other remnants from the window—when it is cleared
from the Workspace. This is sometimes called “window damage.” To clear
these artifacts, you refresh the Workspace. This causes the entire screen, and all
your applications and icons to be repainted.

4 To refresh the Workspace, choose Workspace » Utilities » Refresh.
After a few moments, the artifacts are cleared from the Workspace.

If you are running several types of applications at once (particularly if you are
using SunView applications simultaneously with OpenWindows applications),
you may occasionally find that characters you type in a window are garbled.
This is because of an inherent incompatibility between the way the applications
handle the keyboard.
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Function Keys

The Reset Input utility corrects the problem. If the problem occurs, choose
Workspace » Utilities » Reset Input.

This utility was implemented in compliance with OPEN LOOK functional
specifications, and is provided for use by application developers and for users
to program their function keys. It is not supported by the default DeskSet
applications at this time.

The OpenWindows Function Keys utility is a dynamic on-screen version of the
function keys on the keyboard. (Note that this feature is currently supported
on Type-4 keyboards only.) The function keys on the on-screen utility display
the functions of the current application, providing that application has function
keys support. Otherwise the keys are blank. The key labels are automatically
updated when the pointer is moved to another application.

Because the Function Keys panel is equivalent to the function keys on your
keyboard, you can choose items from the on-screen function keys (by clicking
SELECT on the appropriate key) or from the keyboard itself.

4 To display the Function Keys utility window, choose Workspace »
Utilities » Function Keys.
When you release the mouse button, the Function Keys pop-up window is
displayed at the bottom of the screen.

Note - You must have the Click Select (or “click-to-type”) option set for the
Function Keys utility to work properly. See Section , “Setting the Active
Window,” on page 500 in Chapter 17, “Customizing the Solaris Environment”
for information regarding this option.

Figure 18-1 shows the Function Keys window. In this example, the function
keys have been programmed to modify colors on the workspace.

&

Function Keys

F1

F3 F4 F5 F6 F? 8 9 f10 m F12

F2
(Brick (Blue

Y(Maroon — Y(orchid _ )(Violet  )(Black )(Green Y(Magenta  )(Red J(Clear )( ) )
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Figure 18-1 Function Keys Window
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International Keyboard Support

A range of international keyboards are available through the Function Keys
utility’s multiple language support feature. This feature displays an on-screen
keyboard with keys that correspond to those on the physical keyboard. When
you display one of the international keyboards through a DeskSet or other
XView application, the keys you type on your physical keyboard remap to the
international characters, and those characters appear in the text region of the
XView application window.

To display the keyboard of your choice:
1. Choose Workspace » Utilities » Function Keys.
2. Pin the Function Keys window to the workspace.

3. Click SELECT in an XView application window, such as a Command Tool,
in which you would like to use a set of international characters.

4. Press the Language key on your keyboard, and continue to press it until
instructed to release it.
This key is labeled PrSC, or Print Screen, and is located in the upper right
corner of the keyboard.

Each of the function keys labels displays one of the international languages
that the virtual keyboard supports, as shown in Figure 18-2.

< Function Keys

F4 F5 F6

F F2 F3 7 F8 [3:] F10 m F12
( UK English)(French __ )('Canadian )(Gernan  )(Ttalian  )(Dutch )(Portugese )(Spanish _ )(Show )(Set )( Hore )

Figure 18-2 Function Keys Mapped with the Supported Languages

5. Click SELECT on More to cycle through the available character sets.
6. Click SELECT on the button for the language you would like to use.

7. Click SELECT on the Show button.
The virtual keyboard for that language appears on the workspace. The
French keyboard is shown in Figure 18-3.
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French Virtual Keyboard

i [ B I vt
e e o) lcas]

Figure 18-3 French Virtual Keyboard

8. Pin the keyboard window.

9. Click SELECT on the Set button in the Function Keys window.

Juny

0. Release the language button.

—

1. Begin typing in the XView application window from which you opened
the keyboard.

The characters you type appear in the chosen character set.

Switching Between Virtual Keyboards

You can access a few characters or symbols from another language or alternate
character sets interactively, and then return to typing with your usual character
set. For example, you might want to type a few Greek characters inside a
document that is in English. To change to a different character set and back
again:

1. Open the document and enter the text in your local language.
2. When you want to switch languages, press and hold the R2 key.

3. In the Function Keys window, click SELECT on the button for the
language to which you want to change temporarily.
Continue to press the R2 key.

4. Type in the characters you want to add.
These characters appear in the document in the language you have chosen.

5. Release the R2 key.
Anything you type now appears in your local language.
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Window Controls

The Window Controls menu items cover basic window operations, such as
opening, closing, and resizing windows behind other windows. This utility is
especially useful for performing operations on multiple windows or icons

" simultaneously.

4 To open Window Controls, choose Workspace » Utilities » Window
Controls.
Figure 18-4 shows the Window Controls utility.

’=£§ Works pace
Programs [
Refresh
Properties... Reset input
Function Keys {2 Window Controls
Help.. o apen,fclose
Desktop Intro... .
Save Workspace Full/Restore Size
Exit. Lock Screen Back
Consaole.. Quit

Figure 18-4 Window Controls Submenu

Since Window Controls is a submenu. To make use of this utility, it is usually
best pinning the workspace.

Using Window Controls

The items in the Window Controls submenu correspond to items in the base
Window menu that you pull down from the header of an application window.
Any choice you make in the Window Controls submenu—such as Quit—affects
the currently selected window or windows.

The following examples illustrate the use of window controls on a group of
selected windows or icons. To select multiple windows, either click SELECT on
one window and ADJUST on additional windows (or icons), or position the
pointer on the workspace near the applications you want to group, press
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SELECT, and drag the pointer diagonally across the workspace to create a
rectangle around the series of windows. Any windows or icons completely
inside the rectangle formed by the dragging motion are included in the group.

Opening a Group of Applications from Icons

To open a number of applications at once, select the group of icons (using one
of the methods described above) and then choose Open/Close from the
Window Controls menu. Similarly, you can close a group of applications to
their icon form without having to close each one individually.

Resizing a Group of Applications or Icons

To increase the size of several applications on the workspace, select the group
of windows and choose Full/Restore Size from the Window Controls
submenu. This operation increases the size of the selected application windows
to the full height of the screen.

Choosing Full/Restore Size in the Window Controls submenu a second time
(without deselecting any of the windows) decreases the size of each of the
windows in the group to its former size.

Moving a Group of Applications to the Back

Selecting a group of windows quickly and moving them behind another
window. To do this, select the group you want to move to the back and choose
Back from the Window Controls submenu.

Quitting a Group of Windows

You can quit a number of applications at once by selecting the group of
windows or icons and choosing Quit from the Window Controls submenu.
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Save Workspace

Lock Screen

When you have applications you want to display on the workspace on a
regular basis, you may want to save the workspace layout. This means
applications will display when you exit the Solaris environment and enter
again. You can save the workspace as often as you like—whenever you
develop a new arrangement.

To save the Workspace, first arrange your icons and windows in the locations
you want them to remain, and close any windows that you want to be closed
to icons whenever you start the OpenWindows software. Now choose
Workspace » Utilities » Save Workspace.

In a few moments, a notice informs you that the Workspace layout has been
saved. You must click SELECT on the OK button to continue.

The Lock Screen utility covers the Workspace and the objects in it with a
moving pattern. This provides a certain amount of security for your system
when you are away from your desk. Additionally, it prevents the electron beam
inside the monitor from burning an image into the internal phosphorescent
coating. This can happen if the beam is allowed to fire at one location for an
extended period of time. For information on setting the screensaver feature
refer to Chapter 17, “Customizing the Solaris Environment.”

When your screen is locked, the OpenWindows software continues running
even though the workspace cannot be viewed. Applications that were running
continue running, and any processes currently underway continue. When you
unlock your screen, the workspace is exactly as it was when you locked it.

¢ To engage the Lock Screen utility, choose Workspace » Utilities » Lock
Screen.

In a moment, a moving pattern appears on a black background over the
workspace. To unlock your screen again, press any key on your keyboard, or
any button on your mouse. Type your password and press Return to display
the workspace.
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The Console is the small window that normally appears in the upper left
corner of the workspace when you start up the OpenWindows software. Its
primary use is to display messages from your system and server. You can only
have one Console running, and you should keep it open at all times for
important messages. Figure 18-5 shows the Console window.

cmdtool (CONSOLE) - /bin/csh
examp] ex,

—GI0 |

Figure 18-5 Console Window

4 If you do not have a Console, you can open one by choosing Workspace »
Utilities » Console.

When the Console appears, resize it so that it is just large enough to print
about four or five message lines, and move it to one corner of your screen.

You can scroll up and down through the messages that appear in your Console

by placing the pointer on one of the scrollbar arrows (up or down) and clicking
SELECT.
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The AnswerBook Navigator and Viewer are a pair of windows for browsing,
searching, bookmarking, and printing on-line document collections, also
known as AnswerBooks.

To start the AnswerBook Navigator to see AnswerBooks that may be available
to you:

4 Choose Workspace » Programs » AnswerBook.

Note — AnswerBooks are available to you if your system or site administrator
has installed them and configured them for your use. See the Solaris 2.2
AnswerBook Administration Guide, or ask your administrator for more
information.

The Contents of Your On-Line Library

When the AnswerBook Navigator opens, it displays the contents of your on-
line Library. Your on-line Library may contain the Solaris 2.2 User’s
AnswerBook, a collection of basic manuals to help get you started using your
Sun system. Your library may also contain other AnswerBooks, provided that:

® Your system/site administrator has installed them and configured them for
your use, and

®* You or your administrator has included them in your Library (see
“Modifying Your Library”).
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AnswerBook Navigator and Viewer

Together the AnswerBook Navigator and Viewer give you access to your
Library. You locate what you want to read in the Navigator, and then read it in
the Viewer, where it appears page for page as it would in a printed book.

AnswerBook Viewer

i AnswerBook Viewer R

——

(View w) (Print.)

AnswerBook Navigator AnswerBook Navigator R
's GUi
K (View ) (Modify Library..} (‘New Bookmark..) s ide
IContentﬂ Search I Bookmarks l
Location:
=
Library
N « Solaris User’s AnswerBook |
Arrow indicates *where uh Solaris User’s Guide (Book) )
you are” in the Library
(which document is
open)
= N
Contents of Solaris User’s Guide: ‘
7 3
/i(f Cover |
The expanded contents .| Credits -
of the document or topic » Contants
% Preface
1. Starting up the Selaris User Environment
2. Intreduction
3. Desktop Management Tools
4. Productivity Toels
5. Media Tools
6. Customizing Tools
7. Utilities

—

Figure 19-1 Documentation in the Navigator and Viewer
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The AnswerBook Navigator acts as a kind of remote control for the Viewer.
Using the controls in the Navigator, you locate the information you want and
then display it in the Viewer.

The Navigator provides three ways of finding on-line information:

® In Contents mode you can select an AnswerBook, and then browse through
it, opening and closing books, chapters, and sections, as needed.

® In Search mode you can enter a search phrase describing what you're
looking for, and the Navigator displays a list of documents found, ranked
by relevance.

® In Bookmarks mode, you can go directly to pages where you previously
created electronic bookmarks and edit them.

/ AnswerBook Navigator 1

(View) (Modify Library..) { New Bookmark..)

The three Navigator modes ———1 [ Contents | search | Bookmarks |
* Contents Location:
* Search # Library

¢ Bookmarks

Click SELECT on a mode to
change the functioning of
the window.

[|——(_[3]]

Caontents of Library:

| Solaris User AnswerBook |

KINEL]

>

L "

Figure 19-2 AnswerBook Navigator in Contents Mode
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To open a selected
document (or double-
click SELECT on its

Use the AnswerBook Navigator window to:

Search for topics of interest

Modify your Library (by adding or removing available AnswerBooks)
Select and open an AnswerBook

Select topics for display in the Viewer

Browse through tables of contents

Leave bookmarks and comments on pages within a Library

To add or remove To create a bookmark for
AnswerBooks to/from the current Viewer page

the Library\ /

] \ AnswerBook Navigatty/ L

bold title) \

To see the contents of the
Library

/

Shows location in the
Library

/

Shows contents and
lets you browse

/

\ v
\6Uiew) ( Modify'Library.. ) ( New Bookmark.”) | To change to Book-
marks mode

4Contents I Sea\.rch | Bookrmarks
|

Location: To change to Search
mode

Library
Solaris User’s AnswerBook
[~ up solaris User’s Guide (Book)

[Jm—faT T2]]]

Contents of Solaris User’s Guide:

| Cover |
N Credits
| 3 Contents
Preface
. Starting up the Solaris User Environment
. Introduction
. Desktop Management Tools
. Productivity Tools
. Media Tools
. Customizing Tools
. Utilities

4 1#]]

Nl h N~
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Figure 19-3 AnswerBook Navigator Functions
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Look up page info and

Use the AnswerBook Viewer to read the documents you select in the Navigator
and to print them. You can read pages sequentially or follow hypertext cross-
reference links from topic to topic.

Select printing options

modify/adjust the display \

Page-turning buttons

Current page in

the Viewer \

Cross-reference
hypertext link to

"5 \

AnswerBook Viewer

—

Introductiorto the Uiser Environment

This chapter provides an intreduction to the Openind ows erwirormment and
the DeskSet applications, which are a set of default programs—such as an
electronic mrail application and a text editor—that are included in the

OperWindows software package. The first rmajor section.
desktop

eI ows Erwirorment Jd escribes the elements of your
erzironment and how touse them. The second major section,
SALUCTIENLANC UG IO

describes how to choose the right

another section

application for the task yaa need to accamplish

This introductery information is also available as on-lire help, described at the
end of this chapter. You canchoose the method of learning that is most
corrfertatle for yau,

Those who have had previaus experience with the Open'Wind owrs ererironment

rray want to skip this introdu ctary chapter and move an to Chapters 3 thraugh
7 for more detailed discussions of the OpenWindows DeskSet toals,

Ovwerview of the Environment

When you start the OpenWindows software, you see the Worksprce background
on your screen, as well as the DeskTop Intro, described later in this chapter.
The Werkspace is the display area for cbjects such as windows, feons, and
ments, shows a portion of the Warkspace with several open
application windows, Notice that the windows can overlap each other

17

L User’s Guide at 115%

With each click

\here, you return

the Viewer to the
last successive
page you viewed

Figure 19-4 AnswerBook Viewer Functions
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Closing or Quitting the AnswerBook Navigato? and Viewer

You can close the Navigator and Viewer windows separately. The closed
Navigator and Viewer windows are represented by the icons in Figure 19-5.

Navigator Viewer

Figure 19-5 AnswerBook Navigator and Viewer Icons

Close each window by choosing Close from its window menu or by pressing
the Open key on your keyboard (which toggles Open/Close).

You can quit each window, or its icon, by choosing Quit from its window
menu. When you quit the Navigator, you quit both the Navigator and the
Viewer; quitting the Viewer quits only the Viewer.

You can also use the keyboard equivalents that apply to all DeskSet
applications to close or quit the Navigator and Viewer. For more information,
see Chapter 17, “Customizing the Solaris Environment.”

The default mode in the AnswerBook Navigator is Contents. In Contents
mode, the Navigator has two panes: Location and Contents. Initially, the
Location pane lists your Library, and the lower Contents pane lists the
AnswerBooks in the Library.

Opening an AnswerBook

To see more of the contents of an AnswerBook:

4 In the lower Contents pane, double-click SELECT on a bold AnswerBook
title.

The title expands to show more contents.
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{view) (Modify Library..) ( New Bookmark..)

|Contents | Search | Bookmarks |

Location:

all

Library

#)  Solaris User's AnswerBook Double-click SELECT to open

s (expand) the book’s contents

N

Solaris User's AnswerBook

m@/ Solaris User's Guide (Book)
Ly /

L~

Contents of Solaris User’s AnswerBook: /
) =
Solaris Product Notes F‘— AnswerBook Navigator o
| Solaris User’s Guide (Wiew) (‘Modify Library..} ("New Bookmark...)
Reference Guide
IContents I Search | Bookmarks |
Location:
 —
Library bt

—

Expanded book contents/ Contents of Solaris User’'s Guide:

2]

appear here | Cover

Credits
| 4 Contents

Preface
\ 1. Starting up the Solaris User Environment

2. Introd uction

3. Desktop Management Toaols
4. Productivity Tools

5. Media Tools

6. Customizing Tools

7. Utilities

L

Figure 19-6 Opening (Expanding) a Title in the Navigator
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Navigating Through Sets and Books in an AnswerBook

With the AnswerBook contents expanded, you can browse its sets and books.
Some books appear in more than one set.

To expand any boldface listing, double-click SELECT on it. When you do so,
the listing expands to show more of its contents.

r‘ AnswerBook Navigator

@ AnswerBook Navigator

{View) (Modify Library..} (New Bookmark..) @

IContents I Search I Bookmarks |

Location:

(view) ( Modify Library..) ( New Bookmark..)

| Contents I Search I Bookmarks ’

Location:

Library
Solaris User’s AnswerBook
E” solaris User's Guide (Book)

Library
Solaris User’s AnswerBook

Solaris User’s Guide {(Book)
o Preface
-1 \\

(=l L3I}

Contents of Solarisﬁér’s Guide:

Contents of Prefac&: N

Cove
Credjts
Contents

I
[ How this Manualis Organized

Conventions
Resources afid Support

| Preface

»

1
2. Introduction

3. Desktop Management Tools
4. Productivity Tools

5. Media Tools

B. Customizing Tools

7. Utilities

. Starting up the User Environment

2]

[4

Figure 19-7 Expanding the Contents of a Book in the AnswerBook Navigator

With each expansion, the Contents list grows to reflect deeper levels of the
documentation—sets, books, chapters, and headings. For example, if you

double-click on a set title, the title moves up into the Location pane, and the list

of books contained in that set is displayed in the Contents pane below.
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When you double-click SELECT on any listing at or below the book level, the
first page of that topic or document opens in the AnswerBook Viewer.

To display entries that have scrolled out of sight, use the scrollbar or Scrolling
List menu (displayed by pressing MENU) in either pane to locate it, as shown
in Figure 19-8.

Sun User's Set| ¢opling List B

Sun Administrs -
Locate Choice ) §

sun DEUEIDDE" ......................................................
Sun Hardware Set

Figure 19-8 Scrolling in the Location or Contents Pane

Viewing a Book

In the AnswerBook Viewer, you can turn the pages of a book, chapter, or
section almost as if you were reading a printed book. You can also follow
hypertext cross-reference links between sections, chapters, and books.

Turning Pages

To turn pages, click SELECT on the page-turning buttons at the top of the
AnswerBook Viewer, or click SELECT on the Go Back button to retrace your
steps successively, page by page. See Figure 19-4.

Keyboard Shortcuts

You can use keyboard shortcuts for the paging commands.

PgUp works like the previous-page button.

PgDn works like the next-page button.

Undo works like the Go Back button.

Home displays the first page of the chapter you're in. If you're already at
the first page of a chapter, Home displays the first page of the previous
chapter.

* End displays the first page of the next chapter.
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Checking Your Location in the AnswerBook

Choose Page Info from the View button menu in the Viewer to look up the
origin of the page currently on display. The Page Info window, shown in
Figure 19-9, is displayed.

Rl Page Info
The current page is:

User’'s Guide (Book}
Preface
How this Manual is Organized {(Section)

Figure 19-9 Page Info Window

Each time you choose the Page Info option, you see an update of the
information for the current page.

Following Hypertext Cross-Reference Links

Hypertext cross-reference links appear as text boxed with a thin outline.

For information about booting or halting a workstation over a network, see
Sysient and Nefwork Adminisirasion|

Figure 19-10 Hypertext Link in Text

You can follow hypertext cross-reference links within or between books. The
quickest way to follow a cross-reference link is to double-click SELECT on the
boxed link. Or, you can click SELECT on the hypertext link, then press MENU
on the View button and choose Follow Link, as shown in Figure 19-11.

522 Solaris 2.2 User’s Guide—May 1993



AnswerBook Viewer

( GoBack)

Page Info ...
Partial Page

1 Base Window
The AndicTeol icon is shown in BEEteES].

Standard Magnification
Custom Magnification .. [

=

MudioTeok

Figure 2-1  AudicToolIcon

Figure 19-11 Following a Link

Note — If, when you attempt to follow a link, you see the message, “Can’t
follow hypertext link” at the bottom of the Viewer window, the link may point
to a document that is not among the AnswerBooks in the Library.

Searching with the Navigator

In Search mode, the Navigator can match your requests by searching through
the text and titles of all documents you have included in your Library. You can
enter search phrases in your own words, and enhance your searches (see
“Advanced Search Techniques” on page 527).

To change to Search mode, click SELECT on the Search setting in the control
area. The Navigator in Search mode is shown in Figure 19-12.
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Put Navigator in
search mode

Type search.

L E AnswerBook Navigator Y

( View ) (Modify Library..) (New Bookmark... )

|Contents Seich Bookmarksl

Search Library For:

phrase

elvi;

icanli

(Start Search)  ( Previous Searches..) (Search Settings...)

Documents Found:

a]l

L =L

Figure 19-12 AnswerBook Navigator in Search Mode

To search for a topic of interest:

1. Begin a search by typing a search phrase—a word, phrase, or sentence—in
the pane marked “Search Library For.”
Type any text up to 1024 characters including spaces and punctuation. Edit
the search phrase as you would in any text window.

2. To start the search, press Return at the end of the search phrase.
Or, you can click SELECT on the Start Search button.

When the search is complete, relevant topics are listed in the Documents
Found pane. The topics are coded with squares, starting with black (most
relevant) to white (least relevant), with shades of gray in between.
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= AnswerBook Navigator

(Wiew) ( Modify Library..) ( New Bookmark..)

| Contents E{ﬂl Bookmarks |

Search Library For:

elvi%

{StartSearch)  ("Previous Searches..} (Search Settings...)

Documents Found:

Black indicates most relevant
document or topic

jjxInyi

| §
5.3 The ping Command (3dministering TCP/IP)
grep as a Filter (User’s Guide)
Determining If a Machine Is Alive on the Network Using ping
[ ] Displaying Routing Table Status {Administering TCP
|:| The Name-to—Address Mapping Libraries (Network
|:| 9.1 The ping Command (Administering Security.
a3
I

Figure 19-13 Documents Found in a Search

To see a topic found in the search:

That page is then displayed in the Viewer.

3. Double-click SELECT on an item in the Documents Found pane.

Figure 19-13 shows the result of a search. Each item points to a location in the
Library where a document that matches your request was found.

Scroll the list in the Documents Found pane of the Navigator to see more

items in the list.
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Reusing and Changing Search Phrases

Your search phrases dating from the last time you started the Navigator are
saved so you can reuse them. You can reuse a search phrase as is, or you can
edit it before starting a new search. Click SELECT on the Previous Searches
button. The Previous Searches window is displayed.

o:ﬁ AnswerEook Navigator: Previous Searches
{ —
grep
C++
r Y
news
¥
=]

Figure 19-14 Previous Searches Window

Your search phrases are listed with the most recent at bottom. You can copy
and paste a phrase from the Previous Searches window into the Search For
pane. Press Return or click SELECT on the Start Search button.

Customizing Searches

To change search settings, click SELECT on the Search Settings button. In the
Search Settings window you can specify various options to control the results
of your searches.

L @ AnswerBook Navigator: Search Settings 4

Search Library by: | Text and Titles | Titles Only I

Sort findings by: | Relevance Only l Relevance and Book |

Limit findings to: 30 [a]=)

L =

Figure 19-15 Search Settings Window
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Search Library by: Text and Titles searches all text included in your Library,
while Titles Only searches only book and chapter titles, and section and
subsection headings.

Sort Findings by: Relevance Only simply lists all documents found in order of
relevance, regardless of the books they appear in. Relevance and Book means
the documents found will be listed grouped by book, with topics within a
given book listed by relevance.

Limit Findings to: Click SELECT to increase or decrease the default number of
30 findings per search.

Click SELECT on Apply to preserve your settings, or click SELECT on Reset to
undo your choices and restore the previous ones.

Advanced Search Techniques

To make your searches more precise and more productive, you can:

® Restrict (modify) the contents of your Library to constrain the scope of the
search.

® Choose the search setting “Titles Only” to search through book, chapter, and
section titles rather than searching through the full text of documents.

® Use special characters to mark your search phrases for literal, suffix-
expansion, and “nearness” matching.

Scoping the Search by Modifying the Library Contents

By adding or removing AnswerBooks from your Library, you can widen or
narrow the scope of your search. See “Modifying Your Library” on page 533.

Titles Only Searches

The Titles Only option restricts searches to book titles and chapter and section
headings. This search method is useful if you already know terms used in the
titles or headings of documents you are looking for.
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Using Special Characters in Search Phrases

By adding special characters—quotation marks, parentheses, and asterisks—to
your search phrases, you can make searching more precise. You can combine
the characters to further refine your search.

Quotation Marks: Searching for Literal Phrases

Place the search phrase between double quotation marks to find documents
that contain that literal phrase. For example, the search phrase “reading
mail” finds documents containing that phrase. On the other hand, if you type
reading mail, you will find documents containing one or both words.

Parentheses: Searching for Words in Proximity

Place words between parentheses to find documents with those words in
proximity to each other. For example, the search phrase (reading mail) will
find all documents that have “reading” and “mail” within a few lines of each
other, in either order.

Asterisks and Hyphens: Searching for Variations on a Word

Place an asterisk at the end of a word to match all possible endings of the
word. For example, the search phrase chang* will expand to “change,”
“changed,” “changes,” “changing,” and so on.

If you do not know whether a term is one word, two words, or hyphenated in
the documentation, you can insert the hyphen to look for all three forms.

For example, to search for “mail tool,” “mailtool,” and “mail-tool,” type
mail-tool in the Search For pane.

Connecting Punctuation

Words connected by punctuation other than a hyphen are treated character for
character as literal phrases, for example: /usr/local/bin,
win_client_data,and in.rlogind.
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Combining Advanced Search Techniques

You can combine any or all of the above search techniques to further refine
your search. For example:

“chang* mail-tool” finds documents containing literal phrases such as
“change mailtool,” “change mail tool,” “change mail tool,” “change mail-tool,”
“changing mailtool,” “changing mail tool,” “changing mail-tool,” and so on.

“display button” viewer searches for “display button” and “viewer” in
proximity to each other.

Using Bookmarks Mode

Placing bookmarks helps you relocate pages of interest quickly. You can also
use bookmarks to annotate a page with your comments. Note that bookmarks
do not appear on the marked pages. When you put the Navigator in
Bookmarks mode, you'll see a list of all the bookmarks you've created to date.

You can create a bookmark in any Navigator mode, but you must change the
Navigator to Bookmarks mode if you want to read, edit, or delete bookmarks
or print or display bookmarked pages. See “Viewing and Editing Your
Bookmarks” on page 530.

Creating a New Bookmark

To create a new bookmark for the page currently displayed in the Viewer, click
SELECT on the New Bookmark button at the top of the Navigator.

@ ANswerBooK Navigator: New Bookmark

Bookmark for: Rebooting your system

Comment:

F Y

I=C1 120

\ |

Figure 19-16 New Bookmark Window
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In the New Bookmark window, the text at the top specifies the current page.
You can edit the text in the “Bookmark for” field, which is used in the Existing
Bookmarks list when the Navigator is in Bookmarks mode. You can also type
an annotation in the Comment pane.

Click SELECT on the Create button to create the new bookmark. Or, if you
decide not to create a bookmark, dismiss the New Bookmark window.

Viewing and Editing Your Bookmarks
To see your list of bookmarks, click SELECT on Bookmarks.

"5 AnswerBook Navigator K
(View) (Modify Library..y ("New Bookmark..) (Comments..)
I Contents ,Search UaookmarksJ
Bookmarks—-—-———""'r Bookmarks in Library: =
|t~ Solaris User's AnswerBook hd
/ "Cover” in " User’s Guide"
AnswerBook titles ] hd
|~ System Software AnswerBook
|_{— "Can’t Remember Password” Subsection in "User’s Guide’ |
Current —— | "Network Access: Your NIS Password" Suhsaction in User’s
bookmark
| s |
{ Delete Bookmark) 35 )
Comment for: [€] User’s Guide: Basic Troubleshooting
Comment for current don’t use these characters
bookmark S
L]
1
L ]

Figure 19-17 AnswerBook Navigator in Bookmarks Mode
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The Existing Bookmarks list shows the Bookmark titles listed under their
associated AnswerBooks. To see the comment for a particular bookmark, select
(highlight) it in the Bookmarks list.

Editing a Bookmark

You can edit a bookmark directly in the Existing Bookmarks list. When you're
done, save the bookmark changes.

Deleting a Bookmark

To delete a bookmark, select it and then click on the Delete Bookmark button.
The Navigator asks for your confirmation before deleting. Note that you
cannot undelete a deleted bookmark.

Accessing a Bookmarked Page

Bookmarks serve as links to pages you’'ve marked in the AnswerBook Viewer.
Double-click SELECT on a bookmark to display the bookmarked page.
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Bookmark title Bookmarked page

=) AnswerBook Viewer

{(View ) (Print.)

Can’t Resmember Password

If you forget your password, you canret log in. You must ask your system
admrinistrater to change your password to satrething that is easy for you to
remremrber. Onee you can lag in, you rray wart fo charge your password again
50 that 1t ]s kmwn anly to yaa. Ingeneral, long sequences of rurmbers,

e ud other sps:ml charmcters are hard to remermber, whereas
AnswerBook Navigator he earirg special only ta you are easier to rerrember.
(wiew) (Mbdify Library.. ) (New Bookmark..} (Comments..) in Password

- E ary character inyour passwaord, characters that can be
Contents ] Yearch I Bookmarks I by the termiral such as (GG, (THlZ), (G,

. hnd in sorre cases (#) ard (@) should be awoided, The
Bookmarks n Library: bt thess as signals rather than as text characters, and this

= From typing in the password correctly.
Solaris Usef’s AnswerBook
"Cover]| in " User’s Guide" N
v
rarme in all capitals when wau log in, the systemwill
System Sof[tware AnswerBook )ml were uppercase only, All letters will be displayed in
[ "Can’t Remember Password" Subsection in "User's Guide' 1 this, leave capital letters aut of youruserrare when you
"Metwork fccess: Your NIS Password" Subsection in User’s
typed Password
&

fave miskeyed sorrething, If en the third try you still
raur systerm administrator,

0

{ Delete Bookmark )

j

S , . . Ering’ in with homes=#
Comment for: (€] User’s Guide: Basic Trouhleshooting ,

don’t use these characters

is no directary set up for youruse enthe systern If this
b in to arother machine on the retweork, it ray not

ppens when yau los in to your own systern, then yau need
n adrrinistrator to have himor her setup a hore

(2 ]]

(=2

3 -

2-2 User’s Guide: Basie Troubleshooting

Lirmlhlnchhnhnn at 115%

Figure 19-18 Using a Bookmark to Go to a Page in the Viewer
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Modifying Your Library

You can add AnswerBooks to your Library, provided they have been installed
and configured for your use. You can also remove AnswerBooks from your
Library to constrain browsing and searching.

Note - The Solaris 2.2 AnswerBook Administration Guide provides information
for system administrators on how to make AnswerBooks available to users.

1. Click SELECT on the Modify Library button at the top of the Navigator.

Modify Library button
" (=) \ AnswerBook Navigator R
\
{View) (Modi¥y Library..) ( New Bookmark..)
lContents I Search—liBookmarm
Location:
| —
#® Library
||
=
LN
Contents of Library:
|
[ SolarisUser AnswerBook ] ,
’ v
L |

Figure 19-19 Modifying the Contents of Your Library

Using AnswerBooks 533



19

534

The AnswerBook browser opens and displays a list of available AnswerBooks.

Check indicates
AnswerBook included
in Library

- AnswerBook Navigator: Modify Library !
Select AnswerBooks to include in Library:
—l
Compiler C++ 3.0
P 5claris User’s AnswerBook ]
On-Line Catalog
On-Line Encyclopedia
System AnswerBook
(&
@
=3
Aol
L J

Figure 19-20 Choosing AnswerBooks for the Library

2, Click SELECT on each AnswerBook you want to add.
A check mark appears next to each title you select. To deselect (uncheck) an
AnswerBook, click SELECT on it again. If an AnswerBook title is not
checked, it means it is not included in your Library.

When you’re ready, save your selections.

3. Click on Apply.
This updates the Library to include the newly selected AnswerBooks.

AnswerBooks you add to the Library will be included in the Navigator
Contents listing and in your searches.
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Customizing the Viewer

The View button menu provides several ways of adjusting the display in the
Viewer.

Full Page/Partial Page

The View button provides two resizing options.

Full Page: This is the default Viewer page mode. When you drag the resize
corners, you change the magnification of the page but the entire page remains
visible.

Partial Page: Alternatively, in this mode you can choose to display only part of
the page. A vertical scrollbar enables you to view the rest of the page. The
Partial Page option is especially useful when you magnify documents for
easier viewing. Dragging horizontally on a resize corner magnifies the page.
Dragging vertically displays more or less of the page.

¥ AnswerBook Viewer

[iew_v) (Frint.)

2]

Can’t Remember Password

If you forget yourpassword, you cannot log in, You must ask your system
administrater to change your password to something that is easy for you to
remember. Once you can log in,you ay want to change your password again
so that it is known only to you. In general, long sequences of numbers,
punctuation marks and other sp ecial characters are hard te remember, whereas
words that evoke sone meaning special only to vou are easier to remember,

User’s Guide: Basic Troubleshooting at 114%

I —

|

Figure 19-21 Partial Page View

Magnifying the Viewer

The easiest way to magnify the page in the Viewer is to resize the window,
using the OpenWindows resize corners. Or press MENU on the View button to
see menu options for magnification.
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Standard Magnification is the magnification determined by the publisher of the
documents—that is, the default. You can set other magnification values by
choosing Custom Magnification. This opens the Custom Magnification

window.
I Custom Magnification
Magnification Percentage: 114 59 { f———— 200

.
LI S R Y N B RS B B |

Figure 19-22 Custom Magnification Window

1. Drag the slider to the desired value.
Press SELECT on the slider control as you move it. The amount of
magnification is specified in the Magnification Percentage field.

2. Click SELECT on Apply.
This puts the new page magnification into effect.

Clicking SELECT on Reset reverts to the previous setting. Single clicks on
the left or right of the slider cause one-percent increments up or down the
scale.

Printing

Use the Print button in the Viewer when you want to print books, chapters,
sections, subsections, or single pages.

In the Print window that is displayed, you can choose printing options
(Figure 19-23). The default printing option is Current Viewer Page, which
prints just the page you see in the Viewer.
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= AnswerBook Viewer: Print L
Print Choices:
=
Choose the item you want DeskSet Reference
to print T 2 AudioTool
Scroll up or down to set the
number of copies (between
1 and 10) | =
S — . The number of copies
Print to a pr?nter orcreatea—___| Copies: ] [4]#: Total Pages to Print: 16 T multiplied by the number of
PostScript file Destination: pages in the document
Choose a printer Printer: pubs
. - - - Choose print order to suit your
Print Order: | First Page Flrsﬂ Last Page First T printer
Start printing [ Print)
L M
Figure 19-23 Print Window
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Using AnswerBooks



538 Solaris 2.2 User’s Guide—May 1993



Solaris Troubleshooting A

This appendix provides help with some of the problems you may experience
when using Solaris. It is recommended that you read this entire appendix for
information on these problems. The troubleshooting sections in this appendix
are listed by DeskSet, OpenWindows and Workspace Properties categories and
are in alphabetical order within each category for ease of reference.

Some of the information in this troubleshooting section requires a basic
understanding of the UNIX operating system. If you do not understand how to
diagnose or correct problems related to the UNIX operating system, see your
system administrator or someone who is familiar with UNIX for assistance.

DeskSet Troubleshooting

This section provides information about tools in the DeskSet.

Binder Troubleshooting

You can only run one Binder at a time because your user database locks while
the Binder is running. If you cannot start up the Binder, and you receive a
message in your console telling you that you do not have permission to write
to your user database, it's probably because you have another Binder currently
running.

If a File Type entry that you think is associated with a Binder entry is not
showing up, it’s probably because the Binder read in a duplicate of that File
Type entry before it read the Binder entry in question. When there are
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duplicate File Type entries, the Binder only uses the first one it reads. The first
File Type entry that the Binder reads does not necessarily correspond to the
first Binder entry in the base window scrolling list. Therefore, you should use
caution when using the Copy button to copy a File Type entry. If a File Type
entry does not show up for a particular Binder entry, try to find and delete the
duplicate File Type entry.

Calculator Troubleshooting

If the Calculator detects an error, such as division by zero, the word Error is
displayed. The Calculator must then be cleared with the Clr key before any
further calculations can take place.

Calendar Manager Troubleshooting

This section describes basic Calendar Manager troubleshooting.

RPC Problems and Calendar Manager Installation

The Calendar Manager consists of two parts:

* A database manager, called rpc . cmsd (Calendar Manager service), that
maintains the information for the Calendar Manager

e Th

A l(n
108 Lad

The Calendar Manager application cannot function without the Calendar
Manager service.

If your Calendar Manager does not display appointments, or if you get RPC
timeout messages in the console window, rpc. cmsd may not be running. To
check your configuration, use these steps:

1. Open a Command Tool or Shell Tool.
See Chapter 6, “Command Tool, Shell Tool, and Console Window” for
information about the Command and Shell Tools.

2. At the system prompt type ps -e | grep rpc.cmsd and press Return.
This asks for a listing of all processes containing the string rpc.cmsd.
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3. Look at the listing displayed in the window.
Figure A-1 shows a listing that contains the Calendar Manager service
process. You can ignore the entry grep rpc.cmsd in your ps listing.

% ps t7;_JT_E;;E_?EETE;E;rk_\‘*M
196 co IW 0:07 rpc.cmsd
3759 p0 s 0:00 grep rpc.cmsd
%o

o

Figure A-1 A ps Listing Showing the rpc. cmsd Process

If you do not have an rpc.cmsd process running, follow these steps:

Note - If you have a Calendar Manager application running, quit the Calendar
Manager by choosing Quit from the Window menu.

1. Become root.
2. At the system prompt, type vi /etc/inetd.CONF

3. Look for the entry: Rpc . cusd
Make sure the pathname specified is correct and that an Rpc . cmsd entry
exists in the specified pathname. If not, change the path to point to where
the Rpc . cmsd exists. Then view the pid of inetd by typing:

ps -e | grep inetd

Then reread the inetd.CONF file by typing:
kill -1 inetd-pid

4. Restart Calendar Manager.

5. To make sure that the Calendar Manager Service is now running, type ps
-e | grep rpc.cmsd and press Return.

Upgrading SunOS and Calendar Manager

If you are upgrading the SunOS, you need to back up the following directory,
to preserve the information there:

/var/spool/calendar
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Use whatever backup medium is available to you, and restore the directory
when the operating system upgrade is complete.

Missing Calendar Data or NO NAME in Header

If your appointments are not displayed, make sure you have run the
installation script, as necessary. See “RPC Problems and Calendar Manager
Installation” on page 540 for information. Before trying the following
procedure, try restarting Calendar Manager first.

If your appointments are still not displayed, and you see the string NO NAME
in your Calendar Manager header, the permissions are probably wrong for the
/usr/spool/calendar directory and files. Make sure they are exactly as
described in the following steps.

1.

Type 1ls -lsa /usr/spool, and check the permissions for the directory

/usr/spool/calendar.

The permissions need to be exactly: drwxrwsrwt. This should be owned by
daemon in the daemon group. (Get help from your system administrator to
change the permissions, if necessary.)

To check the permissions of your calendar database, type:
ls -1lsa /usr/spool/calendar/callog.<username>.

Substitute your user name in place of <username>. For example, type 1s -
lsa /usr/spool/calendar/callog.egret. The permissions need to be
exactly: -r--rw----. Also, this file needs to be owned by the user and in the
daemon group.

Remote Access Problems

There are two basic symptoms of remote Calendar Manager access problems:

You try to browse a remote calendar where you think you have Browse
access, and all you can see are appointment times.

You try to insert, delete, or change an appointment on a remote calendar
where you think you have access, and Calendar Manager gives you an
Access Denied... error message in the footer of the Appointment Editor.

There are three things you can check to try to fix these access problems:
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1. If you are using the NIS or DNS system, which uses the concept of mail
domains, make sure you are trying to browse a calendar in your domain or
that you have specified the domain in your browse list. For example, if you
are trying to browse the calendar of user Rob in your domain, you can
simply specify Robe@host. If you are in a domain called Eng, and Rob is in
a domain called Corp, you need to specify rob@host .Corp in your browse
list.

2. Make sure that the owner of the remote calendar has really given you
Browse, Insert, and /or Delete access.
In order for the access to occur, make sure both of these conditions are met:

a. Names in the access list must take the form user@host or just user.
(Note that if the name in the access list is just user, access is given to
anyone on your network with that user name.) If you are using the NIS
or DNS system, make sure your name in the access list is not listed in the
form user@domain or user@name.domain.

b. The owner of the calendar must remember to click SELECT on the Apply
button on the Access List and Permissions Properties window.
Check the user ID and group ID on both your workstation and the
remote workstation. The user ID and group ID must be the same in both
locations.

3. Determine your user ID and group ID on each workstation as follows:

a. Look for your password entry in the file /etc/passwd.
If you have an entry in this file, the user ID is the third field (the number
between the second and third colons). The group ID is the fourth field
(the number between the third and fourth colons). For example, if the
entry for user Egret in the /etc/passwd file is:

egret :X4y8r2Bg:3286:10:& West:/home/egret/:/bin/csh

the user ID for user Egret is 3286, and the group ID is 10. The values of
the user ID and group ID should be between 0 and 32767.
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b. If you are using the NIS system, and you do not have an entry in the file
/etc/passwd and the last line of /etc/passwd starts with a ‘+’, check
for an entry in the NIS passwd entries. To determine your NIS user entry,
type ypmatch username passwd in a Command Tool or Shell Tool.

For example, to find the NIS password entry for user Egret, type:

yvpmatch egret passwd

If the system responds with a user entry, the user ID is the third field,
and the group ID is the fourth field.

Adding a Second Calendar on your Workstation

If you'd like to add a second calendar on your workstation, you need to create
a dummy user for that calendar. For example, you might want to add a second
calendar for appointments for your entire work group.

To create the dummy user and new calendar, use the following steps. These
steps assume a basic understanding of UNIX system administration, so you
may need to get some assistance. This assumes you are root.

1. Add a dummy entry in the /etc/passwd file of the workstation where
you want to create the second calendar.
You need to specify a name, a dummy user ID, and so forth.

Bring down the cm and rpc.cmsd processes.

Log in as the new dummy user, and start a new Calendar Manager.

Bo®N

Edit the access list and permissions for your group.

»

Add the calendar name to the browse list.

6. Log out, and log back in with your own login.
You can now browse the new calendar.

Sharing Calendars Across Workstations

If you move around from workstation to workstation, and you want to always
be able to access your real Calendar, you need to have Calendar Manager
running on each workstation. Use the following steps to set up access to your
calendar from multiple workstations:
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1. On your primary workstation, give full access list permissions to your
calendars at the remote workstations. '
For example, suppose user Egret has his real calendar on the workstation
named “work”, and also accounts and calendars on remote workstations
named “sea” and “ocean”. He would add egret@sea and egret@ocean to
his calendar access list, and give these users full Browse, Insert, and Delete
permissions. See the section Chapter 5, “Calendar Manager”, for
instructions.

2. When you are logged in at the remote workstations, browse your real
calendar.
Since you have full access permissions, you can read all your appointments,
change your appointments, and so forth.

In the previous example, when Egret is logged in to “sea” or “ocean” he can
browse the calendar egret@work to access his real calendar.

Note — Do not mount the /usr/spool/calendar directory from a remote
disk. Doing so may result in loss of Calendar data.

Running Different Versions of OpenWindows and Calendar
Manager

If you run an older version of OpenWindows after running the current version
of OpenWindows, the older version of Calendar Manager will not be able to
read your appointment data file. To avoid this problem, back up the following
file before starting the current version of Calendar Manager:

/usr/spool/calendar/callog.<user>

Before you return to an older version of Calendar Manager, restore your old
file making sure you maintain the permissions on the directory and file. If you
browse a calendar that is running a different version from your own, it should
work.
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Clock Troubleshooting .

Displaying seconds for the clock may have a negative effect on system
performance.

If your Workspace color is black, your clock is invisible when it is an icon on
the Workspace. See the man page for clock to learn how to have the clock icon
painted with the Window Background color instead of the Workspace color.

Drag and Drop Troubleshooting

The section describes some of the error messages you may get while
attempting a drag and drop from on deskset application to another.

Drag and Drop: Timed Out

This can occur if the server is unable to connect with the receiving application
within a certain time. The default timeout value for an XView application is
three seconds.

You can change this value by adding a line to your ~/ . Xdefaults file. If you
wanted to change this to five seconds, add the line:

Selection.Timeout 5

to ~/.Xdefaults file and then type xrdb ~/.Xdefaults from a command
line to setup the server with the new timeout value.

Drag and Drop: Illegal Target

The receiving application does not support drag and drop operations.

This message may also appear if the receiving application’s drag and drop
targets are not responding to the sender. If this is the case, restarting the
receiving application may clear up the problem.
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Drag and Drop: Root Window

The dragged object was dropped onto the root window. Normally, this is
considered an error by the sending application, though File Manager assumes
in this case that the item is to be opened.

Drag and Drop: Failed

An unknown, internal error occurred while trying to establish a drag and drop
connection.

File Manager Troubleshooting

This section describes the solutions to common File Manager questions and
problems.

Cannot Format a Floppy Using the File Manager Format Option

If you try to format a floppy using Format from the File Manager File menu
and it does not work, your system may not be set up to run the format
program. Contact your system administrator for assistance.

Custom Icons Not Displayed

If you think you changed a file’s icon with the Binder, but you do not see the
change in the File Manager, make sure that you restarted the File Manager after
you saved the Binder changes. If you have already restarted the File Manager,
recheck your changes with the Binder. Make sure the entry you changed was
saved to your user database with the Binder Save button. Also, make sure the
file displayed really falls into the class of files changed with the Binder.

If your File Manager displays only the three generic types of icons (folders,
applications, and documents), the File Manager was unable to connect with the
Binder database. Check your Console window for error messages indicating
where the problem occurred.
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Deleting Floppy and CD Windows

If you delete a window for a floppy disk or CD, you can bring it back by
selecting them from the Go To menu button. They are always displayed within
the application specific section of the Go To menu. For information on using
the Go To menu refer to Chapter 2, “File Manager.”

Drag and Drop Problems

If you use File Manager to drag and drop a file to another application, but you
get the error message drag and drop: illegal target in the File Manager
footer, the file was dropped in a place that does not recognize the file type or
that does not support drop operations.

File Manager Does Not Display Some or All of Your Files

If files you expect to see in the file pane are not being displayed, make sure you
have not specified a view filter pattern from the File Manager Properties
window which can suppress the display of those files. When a filter is
specified, it is always displayed in the header of the File Manager window. To
clear this up try selecting View » Icon by Name.

Remote File Copy Problems

If you have trouble transferring files between remote systems, you may not
have the correct permissions to access the file, directory, or system, or the
remote system may not be accessible through the network. Contact the person
who owns the files (or the person who asked you to transfer the files) to
change permissions so the transfer will work. To find out if the remote system
is available on your network, contact your system administrator.

View By Content Takes Too Much Time

When the File Manager is viewing files by content, it needs to read and
compress the first screen of files so they can be displayed. For Sun icons,

X Bitmap, and X Pixmap files, this should work fairly quickly. However,
compressing large Sun raster images can take some time. Therefore, if you only
need to look at icon files, be sure to only have Monochrome Icons and Color
Icons set on the Properties: Current Folder or New Folder window for the Files
to View setting.
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Image Tool Troubleshooting
If you try to run Image Tool and you receive the following message:
ld.so.1: imagetool: can’t find file libxil.so.l

Killed

You need to have the XIL packages installed. Contact your system
administrator for assistance.

Mail Tool Troubleshooting

If you run multiple versions of mail programs, Mail Tool may become confused
about the state of your In-Box. If Mail Tool takes a long time to open the
In-Box, it’s possible that a Mail Tool lock file needs to be removed. If there is
not enough disk space for the Save Changes operation, you will need to
remove messages from the current mail file. This section describes how to
recognize and correct these problems. In addition, it describes where you can
find your Mail Tool In-Box and where you can find mail messages you were
composing that were cleared or lost during a Mail Tool or window system
crash.

Running Multiple Versions of Mail

If you run multiple versions of Mail Tool at the same time (or the Mail Tool
application and the Mail program), you may receive notices from your Mail
Tool application advising you to Save Changes or Quit one of the Mail Tool
applications. This is because both versions try to modify your In-Box. Follow
the instructions of the notices to avoid creating confusion about the state of
your In-Box.

If you did not choose Done or Save Changes in the Mail Tool application before
running another Mail Tool application or the Mail program, a notice instructs
you to quit your Mail Tool application. If you did save your changes, you will
be given a choice to either quit the Mail Tool application or Save Changes to
keep it in its original state.

You can avoid having to quit your Mail Tool application by getting into the
habit of choosing Done from the File menu at the end of each day, or when it is
likely that you will be logging into your machine and reading mail from a
remote location.

Solaris Troubleshooting 549



550

If you forget to choose Done, and you remotely log into your machine to read
mail, you can tell Mail Tool to choose Done by following these steps:

1. From a Shell Tool prompt type ps -e | grep mailtool and press
Return.
The listing should look like the one shown in Figure A-2.

% ps -2 | grep mailtool
1431 co IW 0:04 /home/owy3/bhinsmailtool
1438 p1 S 0:00 grep mailtool

Figure A-2  An example of a ps listing for mailtool

2. Look in the left-hand column of the listing for mailtool (not the listing for
grep mailtool) to find the process number (PID).
The process number is the first number on each line.

3. Type kill -USR1 PID and press Return.
In the example above, the process number is 1431, so you would type:
kill -USR1 1431

4. Read your mail as you usually do from the remote location.
The next time you open your Mail Tool, the changes you make to your
In-Box from the remote location are incorporated and recorded as part of the
Mail Tool.

air aY

Caution - The steps above only work with the DeskSet Mail Tool application.
Using these steps for other versions of Mail Tool kills Mail Tool.

Mail Tool Lock File

The Mail utility uses a lock file to prevent two or more processes from altering
your mail spool file at the same time. If Mail Tool quits unexpectedly, the lock
file may be left behind.

If Mail Tool takes a long time to open the In-Box, either when you specifically
request it or when you open Mail Tool after you have chosen Done from the
File menu, check for a lock file. Look in the directory /var/mail for a file
named username. lock, where username is your login name. To remove the
file, from a system prompt type:
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rm /var/mail/username.lock.
For example, if your username is “mary”, you would type:
rm /var/mail/mary.lock

Alternatively, you can find the lock file in the File Manager, and drag it to the
Wastebasket to delete it.

Mail Tool In-Box Location

The default location for the Mail Tool In-Box is /var/mail /username. If the
environment variable $MATIL exists, Mail Tool uses its value as the In-Box
location.

Recovering Messages Being Composed

If you are in the middle of composing a mail message when your Mail Tool
application or your window system crashes, you can recover a copy of the
message from the file dead. letter in your home directory minus the last 80
edits, that is the application keeps track of the number of edits and files saves
every 80 edits. So the most edits lost would be the last 80.

Your message is also saved in the file dead. let ter whenever you click
SELECT on the Clear button in the Compose window or choose Clear message
from the Compose window’s Deliver menu.

See the man page for mail for information about dead.letter and the save
variable.

“Save Changes” Runs Out of Disk Space

If you try to save changes, by selecting Save Changes or Done from the File
menu, or by switching mail folders, and Mail Tool warns that it has run out of
disk space, you must remove messages from the current mail file to make it
small enough to save.

You can remove messages by deleting or moving them. Removing larger
messages helps the most. You can find the largest messages by choosing Size
from the Sort By submenu of the View menu.
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Files Too Large for the Mail Tool Attachment Window

Mail Tool may run out of swap space if you drag-and-drop a file that is too
large into MailTool Attachment window. You can remedy this by increasing
your swap space.

Print Tool Troubleshooting

If a file has an inappropriate print script in the binder database (this is not an
ASCII file and the possible location is SOPENWINHOME/1ib/cetables), the
Print Tool may hang when you use it to print that file. The print script may be
missing the SFILE, SPRINTER, or $COPIES variable. See Chapter 16, “Binder”,
for information about how to change print scripts using the Binder.

If you print a file and the appropriate filter is not available on the printer, you
will receive an error message.

SnapShot Troubleshooting

A potential problem with Snapshot is creating a raster file that has the wrong
dimensions for use with another application. This is described in the following
section.

Using Snapshot Files with Other Applications

If you experience difficulty in using Snapshot files with other applications, it
may be because you are trying to incorporate a snapshot from a grayscale or
color monitor into an application that can only handle black-and-white images.

Raster files have three dimensions: height, width, and depth. Black-and-white
raster files are 1-bit deep. Grayscale and color raster files are usually 8-bits
deep. True color raster files are 24-bits deep. If you take a snapshot on a 4-bit
screen, it is saved as an 8-bit raster file.

You can see the depth of a raster file by typing file rasterfilenameina
Shell Tool or Command Tool prompt, or by selecting the file from the File
Manager and displaying the Information window. In the example shown in
Figure A-3, the listing shows the file properties for all files ending in .rs. As
you can see from the listing, there is one 8-bit raster file (snapshot.rs) and
the rest are 1-bit files.
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[42]castle{winsor}¥ file *.rs

cmdtoolmenu.rs: rasterfile, 461x236x1 standard format image
samplesnap.rs: rasterfile, 114x285x1 standard format image

shapshot.rs: rasterfile, 250x287x8 standard format image
ssprintmenu.rs: rasterfile, 463x126x1 standard format image
ssprintwindow.rs: rasterfile, 293x322x1 standard format image
sssnapmsg.rs: rasterfile, 461x236x1 standard format image
sswindow.rs: rasterfile, 461x236x1 standard format image

[43]castle{w1‘nsor‘}%0

T me—

Figure A-3 Example of a File Command Listing

The best way to convert an image to the same depth as your monitor is to use
Image Tool. You can take the snapshot, View it, and use Save as to select b&w
as the number of colors. Refer to Chapter 13, “Image Tool.”

Tape Tool Troubleshooting

This section describes some common problems you may encounter with the
Tape Tool, and it offers possible solutions.

Checksum Errors

If you receive a checksum error when reading files from a tar tape, there may
be a mismatch between the block size on the tape and the block size you
specify.

To correct the block size, choose Block [/O from the Tape Tool Properties
window. In the text field that appears, type the correct block size (the one from
the tape).

Files Not Written to Specified Directory

If you retrieve files from a tape and they are not copied to the destination
directory you specify, list the contents of the tape to see if the file names are
preceded by an absolute path name. When you retrieve files that have an
absolute path name, that path is used as the destination directory.
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Tape Drive Not Recognized

If you add a tape drive after the initial system installation, shut down your
system and at the OK prompt type:

boot -r
to reconfigure the system to include the tape device name.

In the past the tape device name /dev/rst8 existed in your system
configuration even if you did not have a tape drive hooked up. Now, tape
device names are not automatically included in your system configuration
unless a tape drive is hooked up at the time of installation.

OpenWindows Troubleshooting

You may occasionally receive an error message or encounter some of the
following problems described here. This section offers some possible solutions
to these described problems.

1. OpenWindows startup fails, and you receive this error message:

SOPENWINHOME/bin/openwin command not found

If you receive this error message, you need to check to make certain that
OPENWINHOME is properly set to point to the location in which the
OpenWindows software was installed. Refer to Chapter 17, “Customizing the
Solaris Environment” or the Solaris 2.2 Basic Installation Guide for assistance in
setting up your environment.

2. The OpenWindows software starts up but some or all of the applications are
not available.

If you experience this problem, you need to make certain that your path is set
such that SOPENWINHOME/bin precedes the rest of your path entry.
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core Files

Occasionally, you may find that a process or application fails, leaving a file
named “core” in the directory from which you began the process. A core file
can take up a lot of disk space, so it is a good idea to provide information to
your system administrator regarding the failed program and the location of the
core file for analysis, and, once it is analyzed, delete it.

If you are not certain what process or application failed, open a shell window,
and do the following at your system prompt, substituting your directory name
for core.directory:

example% ed core.directory (Change directory to the location of the core file.)
example% file core

You will receive a message in that shell that tells you the origin of the core
file. Provide this information to your system administrator.

Those with knowledge of the operating system software may want to analyze
the core file on their own. Information regarding two basic debugging tools is
available in the man pages for adb and dbx.

Blank Screen

If you have set the screensaver option (described in Chapter 17, “Customizing
the Solaris Environment”) and your screen turns blank, you can restore your
desktop by moving the mouse in any direction. Although input from any
keyboard key or mouse button will restore your screen, it is advised that you
move the mouse instead. This is because pressing a key creates system input
which means, as an example, that if the pointer is positioned in a text file, you
may insert a character in the text.

Jumbled Text Characters

If you are running applications of several different types (SunView and
OpenWindows applications, for instance), the characters you type in a window
may occasionally appear jumbled.

To solve this problem, place the pointer in the workspace background, and
choose Workspace » Utilities » Reset Input.
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Problems with .xinitrc

If you have an .xinitrc file in your home directory and you are seeing
problems with applications that rely on global OpenWindows resource
settings, one method of troubleshooting is to rename the file to
.xinitrc.orig and restart OpenWindows.

If this solves your problem, you need to either merge changes between the
system version (located in /usr/openwin/lib/Xinitrc) and your .xinitrc
or remove it if it is no longer needed.

Window Damage

Artifacts—or remnants of other windows—sometimes remain on a window
when overlapping windows are cleared away. This is known as window
damage. To redraw the screen, choose Workspace » Utilities » Refresh.
Momentarily, the artifacts will be cleared.

If the damage occurs to one application window only, you can refresh that
application window by choosing Refresh from the pop-up menu in that
window’s header.

Window Frozen when Opening an Application

If you opened an application from the command line in a Shell Tool or
Command Tool window, as in the example below, you may find that your
window freezes up.

example% cmdtool

The best way to open any DeskSet or other XView application on the command
line is to append the command with the ampersand (&). For example:

example% cmdtool &

This starts the application “in the background” so that the parent window from
which you started the application is free for further use.
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Window Does Not Accept Input

If you position your pointer in a text window (such as in Text Editor or the
Mail Tool Compose subwindow), and when you begin typing the text you type
does not appear in the window, it is likely that the window is inactive, and you
must click SELECT in the window to activate it.

Note that the insert point in a text window changes in appearance depending
upon whether that window is active or inactive. If the insert point is active it
looks like a triangle. If it is inactive, it looks like a dimmed diamond.

Figure 19-24 shows an insert point that is active, and one that is inactive.

Active A B Inactive

Figure 19-24 Active and Inactive Insert Points

You can modify your Workspace Properties so that a window’s input area
automatically becomes active when you move the pointer into it, enabling you
to bypass the step of clicking SELECT in the window. This works for the base
window—an application’s main window—but in some cases, such as the Mail
Tool’s Compose subwindow, you always need to click SELECT in the window
to activate it. See Chapter 17, “Customizing the Solaris Environment”, for more
information.

Workspace Properties Troubleshooting

These are problems you can experience while using the Workspace Properties.

Property Settings Are Not Preserved Across Sessions

This is due to an obsolete .xinitrc file. For more information, refer to
“Problems with .xinitrc” on page 556.

Colors Settings Are Not Taking Effect

If changes you made for the window foreground, data area foreground and
background, then it might mean that XView doesn’t respond to these resources

yet.
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Try toset window.color. foreground and window.color.backgroundin
$HOME/ .Xdefaults manually for XView applications.

Message Regarding Colormap Usage

From the Color Properties, if you receive a message about colormap usage and
the program can’t continue, it might mean the colormap is full.

Try to exit the application(s) that make heavy use of colormap resources,
restart the Properties and try again.

Fonts Extend Beyond Button Boundaries, Layouts Appear
Misaligned

Some programs don’t properly handle all font scales.

Icon Backgrounds Don’t Match Workspace Pattern

XView applications control the icons, they don’t use bitmaps.

Color Category Missing

Color settings availability is dependant on hardware.
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Abbreviated menu button

icd

ADJUST mouse button

Application

ASCII

Background

Glossary

A menu button that is displayed as a small square with a hollow triangle
inside the border. The triangle points downward when the menu is displayed
below the menu button, and to the right when the menu is displayed to the
right. Abbreviated menu buttons function just like menu buttons.

The middle mouse button on a three-button mouse, which is used to adjust
(extend or reduce) the selection.

A tool, program, or window that provides the user with particular capabilities,
such as sending electronic mail, printing files, or interacting with the operating
system.

American Standard Code for Information Interchange. A standard data
transmission code used to achieve compatibility between data devices. ASCII
text is plain text that contains no formatting information (such as font style,
size, etc.).

An underlying area on which objects, such as controls and windows, are
displayed.
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Base window
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Basic pointer
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Border box

Bounding box
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Buffer

Button

Button menu
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The primary window for an application.

An arrow pointing northwest that shows the mouse position on the Workspace.

The outline of a window or icon that is displayed while you move windows
and icons by dragging.

A rectangle displayed on the screen to define a region for selection.

An area of memory used for the temporary storage of data as it is being
transferred from one location to another.

A one-choice element of a control area or a menu. Buttons are used to execute
commands (command button), display pop-up windows (window button), and
display menus (menu button).

A menu that is displayed when the pointer is on a menu button and you press
the MENU mouse button.
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Cable
Cable anchor

1

Calendar Manager

Caret

& &

Change bars

| Parity: [ 0dd [Even] None

Check boxes

v
[

Click

Click-to-Type

A cable on the scrollbar that represents the total size of the data you can view
in the pane. The elevator moves up and down the cable to show the position
of the view into the data.

The button at each end of the scrollbar cable.

A DeskSet application supplied with the OpenWindows software package.
The Calendar Manager enables you to schedule appointments and reminders
for any future date and time.

A marker that indicates the insert point in windows that accept keyboard
input. An active caret (ready for text input) is a solid triangle that may blink.
An inactive caret is a dimmed diamond.

Vertical lines on the left side of property window panes that show that a
setting has been modified but not applied.

A nonexclusive setting that shows a check mark in a square box when the
setting is chosen.

To press a mouse button once and release it without moving the pointer.

Another term for the Click SELECT Input Area property (see Workspace
Properties window) that requires you to click the SELECT mouse button in a
window pane to activate that window’s input area. Contrast with Move
Pointer, definition 2.
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Clipboard

A system buffer that provides the means for keeping track of data that is cut or
copied. The Paste key is used to insert information from the clipboard into a
pane. See also Buffer.

Clock
1. The central timing device in a computer. 2. A DeskSet application (which ‘
can be opened from the Workspace Programs submenu) used to show local or ;
international time. !
Color map

An index of colors, implemented by an application. When the application is
opened, its color map is loaded into the hardware, and for each color used an
index number tells the hardware what color to display.

Command button
A button that is used to execute application commands (see Button).

|

Command Tool
A window tool that provides a shell environment within a window that scrolls !
both forward and backward, with use of a scrollbar. See Shell Tool.

Command window
A pop-up window that is used to execute application commands or set
- Browse parameters.

Completion message
A status message in the footer of a window.

Console
The controlling terminal of a computer system that displays system messages.

Control area
An unbordered region of a window where controls such as buttons, settings,

[E samplevool and text fields are displayed.
v =
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Controls

Current item

[ Courier

Cut

Default

DeskSet

Dimmed controls

[

g
RS L

Directory
Double-click

Drag

Objects in a control area, a pane, or on a menu that are used to perform an
action. Controls include buttons, items on menus, exclusive and nonexclusive
settings, sliders, gauges, text fields, and check boxes. See also Dimmed
controls.

An active item in a scrolling list.

To remove a selected object (or objects) from a window and store it on the
clipboard.

1. The specified choice in a menu that is activated if the user clicks SELECT on
the menu instead of choosing an item with the MENU mouse button.

2. A choice or set of choices in a program, provided automatically if no other
choices are specified by the user.

A default set of productivity applications supplied with the OpenWindows
software package. File Manager, Calendar Manager, and Mail Tool are
examples of DeskSet applications.

A control that is inactive. Its representation on a control area or menu is
dimmed to show that it cannot accept input from the mouse or the keyboard.

A division or level in a hierarchical file storage system that contains files and,
optionally, other directories.

Pressing a mouse button twice rapidly as an accelerator that performs a
specific function without using a menu.

To press and hold down any mouse button while moving the pointer—and the
object under the pointer—on the screen.
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Drag area

- 0
=
Dragging modifiers

Electronic mail

Elevator

End boxes

Exclusive setting

| Apples JOranges |

File

File Manager

564

An operation with the mouse and pointer used to select data within one
application and copy or move it to another location in that or some other
application.

The area in the middle of the scrollbar elevator or slider.

Keys on the keyboard that modify dragging actions when they are pressed in
conjunction with a mouse button.

A facility that enables the exchange of information addressed to a particular
individual, or a group, using computer communications facilities.

The part of the scrollbar that has up and down arrows and a drag area. The
elevator rides the scrollbar cable and shows the position of the view in the
pane relative to the total data available.

[ L I e T Taw hhastbning A
. all 1c:\.|.a115u1a1 vuLlulLLy vl
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maximum setting.

A control that is used for mutually exclusive settings and is shown by touching
rectangles. The chosen setting is shown with a bold border around it.

A collection of data stored on a disk and assigned a name.

A DeskSet application that provides access to the file system through graphical
icons that represent various file types. File Manager can be used to load, store,
and browse through files from the Workspace and from within an application.
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File server

File system

Footer

I —

Foreground

Full size

Glyph

Grab handles

Header

E@ Tool j

A sophisticated form of disk server that maintains a complete logical file
system. Networked computer you can independently access information on
the file server. Contrast this hardware term with the software term window
server.

In the case of the SunOS system software, a tree-structured network of files and
directories through which you can move to access the various files.

The bottom area of a window. The footer is used by an application for
information and error messages.

The controls and the pane of a window.

To increase the size of a window to its maximum as determined by the
application. Full Size is an item on the window menu that allows you to
perform that function. After you make a window full size, the label in the item
toggles to Restore Size.

A picture or graphical representation of an object.

The graphical shapes marking the edges of a window. Using the mouse and
pointer, you can grab the grab handles of the window to stretch or reduce its
size.

The band across the top of every window. Each header has a centered title.
Base windows have a Window menu button on the left; pop-up windows have
a pushpin on the left.
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Highlighting

Hypertext

Icon
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printtool

Input area

Insert point

¥

Keyboard accelerator

Locale
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An OPEN LOOK UI implementation that provides on-screen help for each
element in a window. The application provides help for application functions
and elements. The Help function is available from the keyboard.

A visual indication that an object is in a special state. In monochrome
implementations the visual indication is reverse video (white type on black). In
color implementations, highlighting color is a slightly darker shade of the
window color.

The name given to the ability to programmatically link two separate text nodes
(locations). When positioned at a hypertext node, you can go to the other node
by clicking the SELECT mouse button.

A small pictorial representation of a base window. Displaying objects as icons
conserves screen real estate while keeping the window available for easy
access.

The place on the screen that accepts keyboard input. In click-to-type mode,

cyro A 1L

click SELECT to set the insert point in the input area. In Move Pointer mode,
move the pointer into pane; the area is then ready for input.

The specific location in the input area where keyboard input is entered. When
the user sets the insert point, an active caret is displayed.

A key or sequence of keys on the keyboard that quickly perform specific menu
or application functions without using a menu.

A set of conventions that are unique to a geographical area and/or language.
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Localization

man page

Menu

Menu button

( Menu Button v )

Menu item

Menu Item r

Menu mark

v =

MENU mouse button

008

Message

The process of establishing information within a computer system that is
specific to the operation of particular native languages, local customs, and
character sets.

Another word for a reference manual page, an on-line resource for information
about tools, programs, commands, and applications.

A rectangle containing a group of controls. Menus are displayed in two ways:
from a menu button with choices appropriate to the menu button label (button
menu) and from any place on the screen that is not a control (pop-up menu).
The pop-up menu displays choices appropriate to the pointer location.

A multiple-choice control. A menu button always has a menu mark and is used
to display a menu.

An item on a menu with a menu mark pointing to the right that is used to
display a submenu.

A hollow triangle in the border of a button or following a menu item that has
a submenu attached to it. The triangle points to where the menu or submenu is
displayed.

The right mouse button that is used to display menus. (Unless you have
switched the order of the buttons with xmodmap, in which case MENU and
SELECT are swapped.)

Information generated by an application that informs you about the status of a
process.
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Mouse
An electronic or mechanical device that is used to select and manipulate
information on a computer screen.

Move
To remove selected text or graphics from a window and put it on the clipboard.
Also, to change the location of selected windows, icons, text, or graphics by
dragging to a new location.

Network

A system of interconnected computer workstations and servers.

Nonexclusive setting
A list of nonexclusive choices indicated by separated rectangles. The chosen

LBold ]| Halic settings are surrounded by a bold border.
Notice

Window that is displayed when an application generates warning and error
messages that require an action before you can proceed. A Notice blocks input
to the system until you click on one of its buttons.

You have unsaved edits.

Do you want to save them
before loading the new file?

Numeric field
A text input field, with increment and decrement buttons, that is used for
numeric input.

OPEN LOOK
1. A registered trademark of AT&T.
2. The graphical user interface specification upon which the OpenWindows
design is based.

Palette

A set of coordinated colors provided for defining the color of the Workspace,
window background, selection, and caret.

568 Solaris 2.2 User’s Guide—May 1993



Pane
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Paste

Path name

Pinned menu
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Pixel

Pointer

Pointer jumping

Pop-up menu

Text

Cut
Copy
Paste

Paginate
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A bordered rectangle in a window where the application displays its data.

To insert data from the clipboard into a window. Selected data is placed on the
clipboard with the Copy or Cut key.

An identifier for the position of a file or directory within the file system. For
instance, if the location of OPENWINHOME is /usr/local/bin, then
/usr/local/bin is the path name.

A menu that has its pushpin pushed in. A pinned menu is a pop-up window
that remains on the Workspace until you dismiss it by clicking SELECT on the
pushpin.

An abbreviation for “picture element,” the smallest unit that can be displayed
on a computer screen.

Any graphic representation of the location of the input focus on the screen.

When the pointer automatically moves to a specific location, such as to a pop-
up window.

A menu accessed by pressing the MENU mouse button on any area of the
Workspace that is not a control. The menu that is displayed depends on the
location of the mouse pointer.
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Pop-up window menu

Window

Back

Refresh
Owner?

PostScript

Press

Prompt

Properties

Property window
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A window that is displayed to perform a specific function and is then
dismissed. Command windows, property windows, help windows and Notices
are all pop-up windows.

The window menu that is displayed when you press the MENU mouse button
in a window.

A programming language used to produce text and graphics on a printer or
display, originated by Adobe Systems.

To push and hold a mouse button.

The location at which you enter commands. This is often the machine’s host
name, followed by a percent sign, such as:

example%

When you are in “superuser” mode, the percent sign changes to a pound sign:
example#

If the window server is not running, there is one prompt on the screen. If the
window server is running, you can access the prompt by opening any terminal
emulator window, such as a Shell Tool or Command Tool.

Characteristics of an object that you can customize, such as the color of a
window. The OpenWindows Properties Window is available from the
Workspace menu.

A pop-up window that is used to set properties associated with an object, an
application, or a window.
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Pushpin

~H ©

Raster file

Reference manual page

Refresh

Release

Resize corner
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Root window

Screensaver

Scrollbar

T
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Used to keep a menu, property window, or command window displayed on
the screen.

A data file containing an image composed of an array of picture elements
(pixels) composed of consecutive lines, similar to the scans on a television
screen.

See man page.

The process of redisplaying the information on a display screen. Refresh, an
option on the Utilities submenu of the Workspace menu, should be used if
there are spurious characters or artifacts from dismissed windows on the
Workspace.

To stop pressing a mouse button.

Areas that provide an unconstrained resizing of the boundaries of the window,
without changing the scale of the contents of the window. Only windows that
can be resized have resize corners. See grab handles.

The highest level window in the window system.

A utility that blanks the display screen after a predetermined length of time.
The screensaver feature reduces image burns on the display screen. You move
the mouse on its pad to clear the screensaver and return to the Workspace.

A control that is used to move the view of the data displayed in the pane.
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Scrollbar menu

Scrollbar

Here to Top

Top to Here
Previous
Split View
Join Views

Scrolling

Scrolling button
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A pop-up menu associated with each scrollbar that is used to reposition the
data in the pane.

Moving through data that cannot be viewed entirely in a pane.

An abbreviated button, with a solid triangular arrowhead inside the border,
that is used for scrolling.

A pane containing a list of items. The list can be read-only or it can be edited.

The left mouse button which is used to choose objects, set the insert point,
manipulate controls, and drag objects. (Unless you have switched the order of
the buttons with xmodmap, in which case SELECT and MENU are swapped.)

HUO O i y | 4505 4 QAL

1. In a computer network, a unit that provides a specific service (such as data
storage and compute services) to network users.

2. A program that provides input and display services for window system
client applications. See File server and Window server.

Controls for choosing predetermined values (see Exclusive setting and
Nonexclusive setting).
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Shell Tool

Shrink

Slider
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Magnify Help

© Application Help: Pushpin

Status message

Submenu

Text duplicate pointer

Text field

File Name: Docl

Text move pointer

Text region

A window tool that provides a shell environment within a forward scrolling
window only. See Command Tool.

To resize a window so that its area is reduced.

A control used to set a value and give a visual indication of the setting.

A brief message pertaining to the object under the pointer when the user
presses the Help key.

Information generated by an application that informs you about the progress
of a process.

A menu that displays additional choices under a menu item on a menu.

The pointer that is displayed when you duplicate text directly by dragging.

An area in a window into which you type text from the keyboard.

The pointer that is displayed when you move text directly by dragging.

A multi-line area in a window into which you type text from the keyboard.
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Tool

Undo
Wastebasket
Window

Window border

Window button

Window manager

Window menu

Window

Full Size
Properties...
Back
Refresh

Quit

574

An application or utility program used to enhance productivity on the Sun
Workstation.

To return an object to its state before you performed the last operation. The
number of levels of undo are determined by the application.

A DeskSet tool that is bound to the File Manager application and is used as a
temporary repository for deleted files.

A rectangle containing application elements. See also Base window and Pop-up
window.

The part of the window, including the header, footer, and sides of the window,
that you can use to select a window, set the input area, move by dragging, and
display the window menu.

A button that is used to display a window containing additional controls.

The window manager is a special program that handles the arrangement of
windows on the screen. It allows you to open, close, move, and resize
windows. It also provides facilities, such as the Workspace menu, for starting
and stopping application programs.

The menu that is accessed from the background of a window. Pop-up windows
have a window menu with slightly different choices than those of the base
Window menu.
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Window menu button

&

Window server

Workspace

Workspace menu

.0 Workspace

Utilities >
Properties...
Exit

Workspace Properties window

.Xdefaults file

The abbreviated menu button that is always displayed at the left of the header
in each base window and can be used to execute the default setting on the
window menu (by clicking the SELECT mouse button) and to display the
window menu (by pressing the MENU mouse button).

The program that coordinates output from application programs and input you
provide through the mouse and the keyboard to display windows on your
screen. The window server in the OpenWindows software is called the
X11/NeWS Server because you can run either X11- or NeWS-based application
programs.

The background screen area on which windows and icons are displayed.

The menu from which the DeskSet applications and utilities can be opened.

The Property window accessed from the Workspace menu through which you
customize the Workspace environment.

An OpenWindows file in the your home directory that stores the current
properties of the Workspace. These properties include the color of the
Workspace and windows, the locations of icons, and so on. The .Xdefaults
file can be edited either with the Workspace Properties window available from
the Workspace menu, or directly edited using a text editor.
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Index

Symbols

% Calculator key, 307

&16 Calculator key, 320

&32 Calculator key, 320

( Calculator key, 307

) Calculator key, 307

*, wildcard search, 88

+/- Calculator key, 307
.calctoolrc file, 310
.desksetdefaults file, 322
.mailrc file, 218
.text_extras_menu file, 145, 146
.textswrc file, 147
.wastebasket, 93
.Xdefaults file, 145, 322
/etc/aliases file, 215
/var/spool/mail file, 550
< Calculator key, 320

> Calculator key, 320

Numerics

1/x Calculator key, 307
10~x Calculator key, 321

A

Abbreviated Header, Mail Tool, 158

Abs Calculator key, 307

absolute value, 307

Acc Calculator key, 308

accelerator keys, 489

Access List and Permissions
properties, 264

Accuracy (Acc key), Calculator, 308

Add Tree’s Parent, File Manager, 64

adding and deleting text, 139

ADJUST, xxxi

ADJUST mouse button, 8

Again, Edit menu, 133

Alarm controls, Calendar Manager, 234,
237

alarm, Clock, 299

aliases
local, 217
private, 215

All Entries, Binder, 454
allnet, Mail Tool, 218
And Calculator key, 320
AND, logical, 320
AnswerBook
bookmarks, 529
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searching, 523
application

default, 11

See also applications by their

respective names, 34

starting, 34
application icon, File Manager, 57
Application text field, Binder, 460
appointment

reminders, 240

scheduling, 235
appointment list

Calendar Manager, 229
appointments

Appointment Editor, 231

pop-up window, 232

deleting, 238

editing, 239

finding, 241

repeating, 236

scheduling, 231
Appt/ToDo, Calendar Manager, 233
arc cosine function, Calculator, 321
arc sine function, Calculator, 321
arc tangent function, Calculator, 321
arithmetic precedence, 307
Asc Calculator key, 307
ASCII, 307
ASCII text editor, 127
attached file

caution about executables, 176
attachments, Mail Tool, 151, 174

adding, 180

attachments pane, 162

deleting, 185

drag and drop, 196

moving, 183

opening, 175

printing, 164

renaming, 182

sending, 178
Audio Control

Auto-Adjust button, 381
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Play window, 378
Record window, 379
Audio Tool, 347 to 382
Auto play on load, 376
Auto play on selection, 376
Confirm on new/load, 376
converting audio files, 369
cursor location, 360
deleting, 355
drag and drop target, 361
drag and drop to Mail Tool, 358
Edit menu, 373
editing an audio file, 354
file conversion window, 369
File menu, 364
Fwd (fast forward) button, 363
inserting audio data, 372
loading a file, 367
loading an audio file, 350
Open window
illustration, 367
Play button, 362
play position pointer, 361
playing an audio file, 350
pointer location, 360
Rec (record/stop) button, 363
recording sound with, 351
Rev (reverse) button, 362
saving an audio file, 353, 369
sending voice mail, 356
Silence detection, 376
Silence threshold, 376
sound segments, 362
status information, 361
stop (Play) button, 362
stop (Rec) button, 363
Temp file directory, 376
Auto play on load, Audio Tool, 376
Auto play on selection, Audio Tool, 376
Auto-Adjust button, Audio Control, 381
Automatically Display Headers, 199

B
Background Color, Binder, 460



background color, Binder, 460
Backspace, Calculator, 308
base window, 29
Audio Tool, 349, 359
Binder, 452
Calculator, 302
Clock, 292
Command Tool, 282
features, 15
File Manager, 56
Icon Editor, 429
Performance Meter, 330
Print Tool, 338
Shell Tool, 287
Snapshot, 422
Tape Tool, 384
Text Editor, 128
Bec, Mail Tool, 161
Beep setting, Calendar Manager, 234, 237
Begin Tree Here, File Manager, 64
Binder, 451
All Entries, 454
background color, 460
base window, 452
bindings, 451
changing, 471
creating, 467
deleting, 471
Color Chooser, 473
database, 453
entries
network, 454
private, 453
system, 454
Entry Types, 453
icon, 452
Icon field, 458
image file, 458
image mask, 459
Local Entries, 454
Mask File, 459
open application, 460
Pattern, 463
print method, 461
properties, 456

Index

File Type properties, 461
Icon properties, 457
Save button, 452
Shared Entries, 454
tag mask, 466
tag offset, 465
tag type, 466
tag value, 466
troubleshooting
can’t start Binder as root, 454
View button, 452

binding, 451

blank screen, 555

Block 1/0, Tape Tool, 393
bookmark, creating, 529
Browse menu, 256
browse menu

deleting a user, 250

browser calendars

adding users, 248

adding users to the access list, 266
changing access list, 267

deleting users from access list, 267

browsing calendars, 243
browsing remote calendars, 256
Bsp Calculator key, 308

C

calctool man page, 322
.calctoolrc file, 310
Calculator

.calctoolrc file, 310, 301
accuracy

Acc key, 308
base window, 302
basic keys

%, 307

+/-, 307

1/x, 307

Abs, 307

Acc, 308

Asc, 307

Base, 302 to 304
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Bsp, 308

Clr, 308

Con, 309

Disp, 304

Exch, 309

Exp, 307

Frac, 307

Fun, 309

Int, 306

Keys, 308

Mem, 309

Mode, 305

parentheses, 307

Quit, 308

Rcl, 309

Sqrt, 307

Sto, 309

x"2, 307
financial keys

Ctrm, 313

Ddb, 314

Fv, 314

Pmt, 315

Pv, 316

Rate, 316

Sln, 317

Syd, 318

Term, 319
function keys, 322
functions

user defined, 309
icon, 302
keyboard equivalents, 311, 322
keyboard mapping, 308
logical keys

&16, 320

&32, 320

<(shift left), 320

> (shift right), 320

And, 320

Not, 320

Or, 320

Xnor, 320

Xor, 320
memory registers, 308
miscellaneous functions, 307
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modes, 302

basic, 305

financial, 312

logical, 319

scientific, 320
performing calculations, 310
scientific keys

107x, 321

Cos, 321

e”x, 321

Hyp, 321

Inv, 321

Ln, 321

Log, 321

Rand, 321

Sin, 321

Tan, 321

Trig, 320

x!, 321

y~x, 321
specifying precedence, 310
troubleshooting, 540
user defined functions, 309

Calendar Manager, 221

introduction, 39

Alarm options, 237

Appointment Editor, 231
Alarm controls, 234

appointments scrolling list, 233

Appt/ToDo setting, 233

Date field, 232

My Eyes Only, 233

Repeat controls, 234

Start field, 232

What field, 233
appointments

appointment list, 229

appointment template, 277

deleting, 238

editing, 239

finding, 241

scheduling, 231

scheduling appointments for

multiple calendars, 251,

253



base window elements, 235
browse access list
adding calendars, 266
changing, 267
deleting calendars, 267
Browse menu, 256
adding a calendar, 248
deleting a calendar, 250
browsing remote calendars, 243, 256
current day, 223
date formats, 269
day boundaries, 262
drag and drop, 242,276
icons, 222
Multi-Browser
Goto button, 245
Mail button, 245
multi calendar display, 246
Schedule button, 245
scheduling appointments, 251
scrolling browse list, 245
selecting a week to browse, 250
navigation controls, 225
permissions, 265
printer settings, 268
properties, 259
Access List and Permissions
properties, 264
Category menu, 260
Date Format properties, 269
day boundaries, 262
Default View, 263
Display Settings properties, 262
Editor Defaults properties, 260,
261
hour display, 263
Printer Settings properties, 268
reminders
Beep, 234,237
Flash, 234,237
Mail, 234, 237
PopUp, 234,237
scheduling appointments, 235
time zone, 258
ToDo list, 229
views, 222

Index

appointment list view, 229
day view, 226
ToDo list view, 229
week view, 227
year view, 229
Calendar template, 169, 214
Capitalize, Text Editor, 136
caret, 9
Cc, Mail Tool, 161
change arithmetic sign, 307
Change Line Wrap, 131
changing
appointments, 239
binding, 471
day boundaries, 262
changing default menu item, 14
characters, jumbled, 555
checksum, 394
checksum error, 553
Circle, Icon Editor, 432
Clear log, 283
Clear log, Command Tool, 283
Clear, Calculator, 308
Clear, Icon Editor, 445
Clear, Mail Tool, 161
Click ADJUST, definition, 8
Click SELECT, definition, 8
click, definition, 8
clicking mouse buttons, how to set time-
out period, 494
Click-to-Type, 500
Clip Lines, Text Editor, 132
clipboard, 133
clipboard, File Manager, 78
Clock, 291
Alarm settings, 299
base window, 292
changing timezone, 296
customizing, 292
icon, 291
keyboard accelerators, 299
properties, 293
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troubleshooting, 546

closing
Help Viewer, 53
Navigator, 518
Viewer, 518
window, 27

Clr Calculator key, 308
cm_delete, 279
cm_insert, 279
cm_lookup, 279
Cmd Modes submenu, 284
collisions, 332
color
brightness, 484
hue, 484
in Workspace and windows, 481
saturation, 484
Color Chooser, Binder, 473
Color Chooser, Icon Editor, 448
color X pixmap image, 442, 446
command interpreter, 282
Command Tool, 282
Clear log, 283
editing command line, 285
File Editor menu, 284
Iistory, 283
icon, 282
Mode Setting, 283
pop-up menu, 283
Scrolling menu, 284
Store log, 283
term pane menu, 283
troubleshooting, 290

Compose menu
Mail Tool, 155

composing email, 166, 167
compounding periods, 313

Con calculator key, 309

Confirm on new/load, Audio Tool, 376
Console, 290, 512

constants, Calculator, 309

context switches, 332

control area, 15
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Copy, Edit menu, 133
copying

files, 62,77

mail messagesMail Tool

messages
copying, 154

text, 140

your email messages, 207
copying files

cut and paste, 78
core file, 555
Cos Calculator key, 321
COS, cosine function, Calculator, 321
cpio command, 383
Create Folder, 60
creating

binding, 467

calculator functions, 312

links, 95

local aliases, 217

mail files, 189

mail messages, 155

new files, 76

snapshot, 423

templates, 169, 213

text, 129

text file, 137
cropping an image

Image Tool, 408
cross-reference links, 522
Ctrm Calculator key, 313
current folder, File Manager, 69
Custom Buttons, Mail Tool, 199
Custom Commands, File Manager, 60, 112
custom field, 206
customizing

Calculator, 326

Clock, 292

clock

time zone, 296

default menu item, 14

File Manager, 99

font scale, 485



fonts, 485
interval between mouse clicks, 494
Mail Tool, 197
mouse
click time-out, 494

press (whether menu selection is

automatic), 497
Performance Meter, 332
pointer jumping, 495
scrollbars, 501
Text Editor, 145
type styles, 485
Viewer, 535
Workspace, 478
customizing your Text Editor, 145
Cut, Edit menu, 133
Cut, File Manager, 62
cutting and pasting text, 141

D

data file, 57
Date field in Calendar Manager, 232
Date Format properties, 269
day boundaries, 262
day view, 226

printing, 271
day view, Calendar Manager, 226
Ddb Calculator key, 314
dead.letter file, 551
default

how to change on a menu, 14

locations of icons, 501

menu choice, 14

how to change, 14

default ring on menus, xxxi
default view of Calendar Manager, 263
default | app Binder entry, 465
default | dir Binder entry, 465
default | doc Binder entry, 465
Degrees, 320
delete

data, from sound file, 355

Index

drag and drop method, 22
file, in Text Editor, 139
text, in Text Editor, 139
Delete method, File Manager, 101
deleting
appointments, 238
binding, 471
files, 62,92
mail messages, 154
messages, 172
Deliver, Mail Tool, 161
depreciation allowance, 314
DeskSet applications
introduction, 34
starting, 35
.desksetdefaults file, 322
Destination field, Tape Tool, 385
Destination Machine, 86
Destination Path, 86
Device field, Tape Tool, 393
Disable Page Mode, 289
disk traffic, 332
Display Characters, Mail Tool, 199
Display Headers, Mail Tool, 199
Display Lines of Text, Mail Tool, 202
Display Settings, Calendar Manager
properties, 262
displaying files, File Manager, 63, 110
Done, Mail Tool, 153, 185
Dot files, File Manager, 107
double-click, definition, 8
drag and drop, 17
Audio Tool, 361
Calendar Manager, 276
File Manager, 79, 95
File Manager to Mail Tool, 178
File Manager to Print Tool, 86
File Manager to Tape Tool, 384
from Audio Tool to Mail Tool, 358
from File Manager to Print Tool
icon, 340
from File Manager to Tape Tool, 388
from Text Editor, 139
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mail attachments, 178, 180, 183, 196
mail onto File Manager, 81
mail to Calendar Manager, 242
mail to Print Tool, 165
Mail Tool, 195, 276
Print Tool, 337
problems, 548
Tape Tool, 384
target, 18
Text Editor, 143, 144
Text Editor to Mail Tool, 179
Text Editor to Print Tool, 141
drag area, on scrollbar, 16
drag, definition, 9
dragging and dropping
Image Tool, 416
drag-right distance, 496

E
e”x Calculator key, 321
Edit, 373
Edit menu
Audio Tool, 373
Binder, 453
File Manager, 62
Icon Editor, 445
Mail Tool, 154
Text Editor, 133
edit menu
Image Tool, 419
editing

appointments, 239
audio file, 354
command line in Command Tool, 285
list files, 385
Mail Tool properties, 208
text file, 139
Editor Defaults, Calendar Manager, 261,
269
editors
Text Editor, 37
vi, 37
Ellipse, Icon Editor, 432
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Empty Document, Text Editor, 130
Empty Wastebasket, 94
Enable Page Mode, 288
ENG (engineering display notation),
Calculator, 304
Enter Function, 311, 312
Erase, Icon Editor, 435
Err Exit, Tape Tool, 394
error messages
Image Tool, 416
Error, calculator, 540
/etc/aliases file, 215
Exch Calculator key, 309
Exclude, Tape Tool, 394
Exp Calculator key, 307
exponential calculator function, 321
exponents, 307
extracting files from tape, 390
Extras menu, 136

F

factorial calculator function, 321
File, 364
file
copying onto tape, 388
creating, in Text Editor, 137
editing, in Text Editor, 139
extracting from tape, 390
saving, in Text Editor, 138
viewing
in Text Editor, 138
saved mail messages, 205
file and folder properties, File Manager
group, 97
name, 97
ownership, 97
permissions, 97,99
File Editor menu, Command Tool, 284
File Manager, 55
introduction, 37
base window, 56
clipboard, 78



copying files, 62,77

cut and paste, 78
creating folders, 60
creating new files, 76
current folder, 69
Custom Commands, 112
customizing, 99
Delete Method, 101
deleting files, 56, 62, 92, 94
displaying files, 56, 61, 63, 69, 110

by Content, 109
double-click accelerators, 59
drag and drop, 79
Edit menu, 62
Empty Wastebasket, 94
File menu, 60
file pane, 56,72
file properties

group, 97

name, 97

owner, 97

permissions, 97,99
Find pop-up window, 89
finding files, 60,87, 90
Hidden files, 107
icon, 55
icons, 57

applications, 57

data file, 57

folder, 57
linking files, 55, 95
Longest File Name, 103
moving data files to workspace, 79
moving files, 77

cut and paste, 78
moving files to a folder, 79
moving files to another

application, 81

moving folder to workspace, 80
naming a document or folder, 77
opening files, 60, 75
path display, 69
path pane, 56
path that is displayed, 70
printing files, 60, 86
properties, 94,97, 114, 116

Index

changing file properties, 99
file, 97 to ??
file and folder properties, 97
File Properties window, 98
folder, 97
Tool Properties, 114 to 116
Tool Properties Window, 114
removing files, 56, 92
renaming files, 77
Select All, 62
selecting files, 58
subfolders, 69
transfering files, 55
transferring files, 86
tree display, 63
troubleshooting, 547
copying files on remote
systems, 548
drag and drop error, 548
files not displayed, 548
icons not displayed, 547
view By Content takes too
long, 548
using Goto, 88
View Filter Pattern, 116
View menu, 61
Wastebasket, 92
File menu
Audio Tool, 364
Binder, 452
File Manager, 60
Icon Editor, 441
Mail Tool, 153
Text Editor, 129
file menu
Image Tool, 417
file pane, File Manager, 56, 72
File Properties window, 98
file properties, File Manager
date accessed, 97
date modified, 97
file type, 97
free space, 98
mount point, 98
mounted from, 98
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open method, 97
print method, 97
file system, 37
File to Write button, Tape Tool, 385
File Type Properties, Binder, 461
files
deleting, 92
linking, 95
Fill menu, Icon Editor, 439
financial functions, 312
Find and Replace pop-up window, 133
Find Marked Text item, Text Editor, 135
Find menu, Text Editor, 133
Find pop-up window, 173
Find pop-up window, File Manager, 89
Find Selection, Text Editor, 134
Find, File Manager, 60
Find, mail messages, 154
finding
appointments, 241
files, 87,90
mail messages, 154, 173
FIX (fixed point display notation),
Calculator, 304
Flash setting, Calendar Manager, 234, 237
flipping an image
Image Tool, 409
Focus-Follow-Pointer, 500
folder, 57
fonts
changing default, 486
customizing, 485
listing, 486
scale, 485
Foreground Color, Binder, 459
format lines of text, Text Editor, 136
Forward, Mail Tool, 155
Frac Calculator key, 307
Full Header, Mail Tool, 158
Fun calculator key, 309
function keys, 491
Function Keys utility, 506
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functions

financial, 312

logical, 319

miscellaneous Calculator, 307

scientific, 320

user defined Calculator, 309
future value of investment, 314
Fv Calculator key, 314

Fwd (fast forward) button, Audio
Tool, 363

G

Goto text field, 88
Gradients, Calculator, 320
Grid Display, Icon Editor, 444
group
change file properties, File
Manager, 99

H

Header menu button, Mail Tool, 161
help
closing Help Viewer, 53
handbooks, 43
magnify, 43
paging through handbook, 50
using hypertext in handbooks, 52
Help button
Image Tool, 416
Hidden Files, File Manager, 107
Hide Snapshot During Capture, 423
Hide Subfolders, File Manager, 64
Hide, Mail Tool, 159, 202
History, Command Tool, 283
$HOME variable, 208, 210
Host Name, Tape Tool, 393
hot spot, 18
Hyp Calculator key, 321

hyperbolic cosine function,
Calculator, 321

hyperbolic function flag, Calculator, 321



hyperbolic sine function, Calculator, 321
hyperbolic tangent, 321
hypertext links, 522

I
icon
introduction, 6
default location, 501
application, 57
Binder, 452
Calculator, 302
Calendar Manager, 222
Clock, 291
Command Tool, 282
data file, 57
File Manager, 55
folder, 57
Icon Editor, 429
Mail Tool, 42
Mail Tool, Compose window, 160
Mail Tool, Header window, 150
moving, 25
Navigator, 518
Performance Meter, 329
Print Tool, 337
Shell Tool, 287
Snapshot, 422
Tape Tool, 383
Text Editor, 127
Viewer, 518
Icon Editor, 429
adding text to canvas, 433
base window, 430
canvas, 430
clearing the canvas, 445
Color Chooser, 448
color controls, 439
color X pixmap, 442
control area, 430
drawing controls, 430, 431
drawing mode, 431
circle, 432
ellipse, 432
erase, 435

Index

line, 432
point, 431
region, 435
square, 432
text, 432
editing icon, 436
erasing in drawing canvas, 438
fill choices, 439
formats, 442,446
color X pixmap, 446
Monochrome X pixmap, 442, 446
X bitmap, 442, 446
Xview icon, 442,446
grid, 444
icon, 429
icon size, 446,447
Invert, 446
menus
Edit menu, 445
Properties menu, 446
View menu, 443
move buttons, 440
preview area, 430
printing, 442

Image File, Binder, 458
Image Tool, 395

controls, 417

cropping, 408

dragging and dropping, 416
edit menu, 419

file menu, 417

flipping, 409

formats, 398

help button, 416

icon, 396

information, 401

multiple page documents, 412
open as, 400

opening an image, 397
palette, 407

panning, 407

printing, 405

properties, 415

rotating, 410

save as, 403
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save page as Image, 404
save selection as, 404
saving an image, 401
standard operations, 419
view menu, 418
View window, 396
zooming, 411

image tool, 395

Include File, Text Editor, 129

Include, Mail Tool, 161

input area
click SELECT before typing, 500
definition, 9
Focus-Follow-Pointer, 500

Insert, 137

Insert Brackets, Text Editor, 137

insert point, 9

Int Calculator key, 306

integer, 306

international keyboard, 507

Introducing Your Sun Desktop tutorial, xxx

Inv Calculator key, 321

inverse function flag, 321

inverse hyperbolic cosine function,
Calculator, 321

inverse hyperbolic sine function,
Calculator, 321

inverse hyperbolic tangent, 321

Invert, Icon Editor, 446

J

jumbled characters, 555

K

keyboard
erase functions, 490
function keys, 491
international, 507
move caret functions, 490
navigation commands, 492

keyboard accelerators
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Clock, 299
Performance Meter, 336

keyboard equivalents
Calculator, 311, 322

Keys, 308
keys
accelerator, 489

L

left-handed use
of mouse buttons, 494
Line, Icon Editor, 432
link, 95
creating, 95
removing, 96
linking files, File Manager, 55, 95
links, 522
list files, Tape Tool, 384
Ln Calculator key, 321
1n command, 95
Load In-Box, 153, 185
loading a file
Audio Tool, 367
Icon Editor, 441

loading a file, in Text Editor, 138

Local Entries
Binder, 454
localization, 502
Lock Screen utility, 511
Log Calculator key, 321
Log Samples, Performance Meter, 335
Log, Mail Tool, 161
logarithm
base 10, 321
natural, 321
logical functions, 312, 319
logical mode, 319
logical shift left, 320
Longest File Name, File Manager, 103



M

Magnify button, 535
Magnify help, 43
Mail File Directory, 209
Mail File menu, 188
Mail File text field, 155
Mail Files menu item, 153
Mail setting, Calendar Manager, 234, 237
Mail Tool, 149
introduction, 41
attachments, 151, 174
adding, 180
attachments pane, 162
deleting, 185
drag and drop, 196
moving, 183
opening, 175
printing, 164
renaming, 182
sending, 178
Show Attachment List, 206
commiting changes, 185
composing messages, 166, 167
custom buttons, 153, 155, 199
custom header fields, 206
customizing, 197
drag and drop, 165,178, 183,195,196,
276
headers
Reply-To header, 206
Return-Receipt-To, 206
icons, 150, 160
In-Box location, 551
loading In-Box, 195
lock file, 550
Mail File menu, 155
mail files, 186
adding messages to, 191
creating, 189
deleting, 193
emptying, 193
Mail File directory, 209
Mail File menu, 188
Mail File text field, 155

Index

Mail Files menu item, 153

Mail Files window, 186

renaming, 193

sorting, 193

viewing, 192
menus

Compose menu, 155

Copy menu, 188,210

Edit menu, 154

File menu, 153

Load menu, 188,210

Messages menu, 156

Move menu, 188, 210

View menu, 154
message headers, 151, 158
messages

creating, 155

deleting, 154,172

finding, 173

forwarding, 155

organizing, 186

printing, 164

recovery, 551

replying, 155

undeleting, 154,172

viewing, 156, 158, 159
Precedence junk headers, 206
printing messages, 164
properties, 197,208

Alias properties, 215

allnet, 218

Automatically Display

Headers, 199
Category menu, 197
Compose Window
properties, 203

Custom Buttons, 199

custom header fields, 206

delivery properties, 199

Display Characters, 199

Display Headers, 199

Display Lines of Text, 202

Expert properties, 217

Header Window, 198

Hide, 202

Ignore host name in address, 218
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Include me when I "Reply to
All", 218
mail arrival properties, 198
Mail Filing properties, 208
Message Window
properties, 201
metoo, 218
Move, Copy, Load menus, 210
Print Script, 202
Retrieve Every, 198
Show "To recipient”, 199
Show Attachment List, 206
Signal With, 198
template properties, 213
reading messages, 169
running multiple versions of Mail
Tool, 549
saving changes, 185
templates, 169
troubleshooting, 549
running out of disk space, 551
Vacation, 155
vacation notifier, 170
viewing saved messages, 205
Voice button, 161
windows
Compose window, 159
MratAariging arind ey aloa
\.\ADL\JIIllLllIs VWILIMUYY D14,
Find window, 173
Mail File windows, 192
Mail Files window, 187, 189, 191
Properties window, 197
Vacation Setup window, 170
View Message window, 156
Mail Tool, templates, 213
man page
adb(1), 555
date(l), 291
dbx(1), 555
Mask File, Binder, 459
Mem Calculator key, 309
memory registers, Calculator, 308
Memory, Calculator, 309
MENU, xxxi

199
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menu
introduction, 10
button, 13
changing default choice, 14
default choice, 14
Programs, 11
secondary, 11
window, 12
Workspace, 10
customizing, 14
MENU mouse button, 8
menu, Workspace, 35
menus, Xxx
message header, 158
selecting, 152
Messages, 154
metoo, Mail Tool, 218
miscellaneousCalculator functions, 307
Mod Time, Tape Tool, 394
Mode setting, Command Tool, 283
Mode, on History menu, 283
modifying OpenWindows defaults, 478
Monitor settings, Performance Meter, 333
Monochrome X pixmap image, 442, 446
month view
printing, 274
more command, 288
mouse, XXX
introduction, 7
buttons
SELECT, ADJUST, MENU, 8
customizing click time-out, 494
customizing press (whether menu
selection is automatic), 497
how to use, 8
keyboard substitution, 489
remapping for left-handed users, 494
move buttons, Icon Editor, 440
move, definition, 9
moving
data files to workspace, File
Manager, 79
files, 77



files to a folder, File Manager, 79
files to another application, File
Manager, 81
folder to workspace, File Manager, 80
moving files
cut and paste, 78
moving icons, 25
moving windows, 23
multi-click timeout, 494
My Eyes Only, Calendar Manager, 233

N

Name, calculator function, 311
naming document or folder, File
Manager, 77
natural logarithm calculator function, 321
Navigator
closing, 518
icon, 518
modes
Bookmarks, 529
Search, 523
quitting, 518
New, Mail Tool, 155
NewDocument, File Manager, 76
NewFolder, File Manager, 76
Next, Mail Tool, 154
No Check, Tape Tool, 394
No SCCS+, Tape Tool, 393
No SCCS, Tape Tool, 393
noauth OpenWindows option, 454
Not Calculator key, 320
NOT, logical, 320
number bases, 302
Binary, 303
Decimal, 303
Hexadecimal, 303
Octal, 303

O

octal (base number mode), Calculator, 303

Index

on-line help, 43
open
icon into a window, 7
text file, 138
OPEN LOOK, xxix
Open window, Audio Tool, 367
opening
files, 60
folders, 60
Image Tool files, 397
opening files, File Manager, 75
OpenWindows
overview of features, 5
reducing use of mouse, 489

SOPENWINHOME

error message, 554
Or Calculator key, 320
OR, logical, 320
organizing mail messages, 186
Orig Mode, Tape Tool, 394
owner

change file properties, File

Manager, 99

P

page overview
Image Tool, 412

page viewing controls
Image Tool, 413

Palette
Image Tool, 407

pane
terminal emulator, 288
text editing, 156
panes, splitting, 142
Panning
Image Tool, 407
parent directory, 63
parentheses, Calculator, 307
password, 3
Paste, Edit menu, 133
Paste, File Manager, 62
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Path Commands menu, File Manager, 70
path pane, File Manager, 56, 69
path, File Manager, 69
Pattern, Binder, 463
pattern-matching, 88
percentage, 307
perfmeter man page, 539
Performance Meter, 329
customizing, 332
displays, 334
dial, 330
icon, 329
keyboard accelerators, 336
Log Samples, 335
monitoring remote machine, 334
monitors, 333
needles, 330
Properties window, 332
Sample Time, 335
Show collisions, 332
Show context, 332
Show cpu, 331
Show disk, 332
Show errors, 332
Show interrupts, 332
Show load, 332
Show packets, 331
Show page, 331
Show swap, 331
performing calculations, Calculator, 310
periodic interest rate, 316
periodic payment calculation, 315
permissions
files and folders, 97,99
group, 99
owner, 99
world, 99
Play button, Audio Tool, 362
Play window, Audio Control, 378
playing sound, with Audio Tool, 350
+/- Calculator key, 307
Pmt Calculator key, 315

Point, Icon Editor, 431
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pointer
introduction, 7
and input area, 500
drag distance, 496
jumping, 9
list of types, 7
movement on scrollbar, 495
on pop-up windows, 496
pop-up menu, 283
PopUp setting, Calendar Manager, 234,
237
pop-up window menu, 12
Precedence junk header, Mail Tool, 206
present value calculations, 316
Press MENU, definition, 8
Pretty-print C code, 137
Previous, Mail Tool, 154
Print Method, Binder, 461
Print Script, Mail Tool, 202
Print Tool, 337
introduction, 40
base window, 338
drag and drop, 337,341
features, 41
how to stop a print job, 343
icon, 337
printer
choosing, 341
default, 346
queue status, 342
status messages, 339
troubleshooting, 552
Printer Settings, Calendar Manager, 268
printing, 86
day view, 271
drag and drop, 165,337
File Manager, 60, 86
icons, 442
mail messages, 153, 164
mail messages with Print Tool, 341
month view, 274
queue status, 342
Text Editor files, 141
week view, 273



year view, 275
Printing Images, 405
program names, 35
Programs menu, 11
Programs submenu, 35
programs, See application
prompt, 16
properties
Binder, 453, 456
Calculator, 326
Calendar Manager, 259
changing file properties, File
Manager, 99
day boundaries, 262
default view, 263
file and folder, File Manager, 97
for the Workspace, 478
Icon Editor, 446
Image Tool, 415
Mail Tool, 154, 197
Performance Meter, 332
Tape Tool, 385
template, 213

pushpin, 12
Pv Calculator key, 316

Q

Quit Calculator key, 308

quitting
Help Viewer, 53
Navigator, 518
Viewer, 518
window, 27

R

Radians, Calculator, 320

Rand Calculator key, 321

random number calculator function, 321
Rate Calculator key, 316

Rcl Calculator key, 309

Read Entire List, Tape Tool, 387

Read Entire Tape, Tape Tool, 388

Index

read files from tape, 387
read files, Tape Tool, 384
Read Selected, Tape Tool, 387
Read settings, Tape Tool, 394
reading email, 169
Rec (record/stop) button, Audio Tool, 363
Recall, Calculator, 309
Record window, Audio Control, 379
recording sound, with Audio Tool, 351
Refresh utility, 505
Region, Icon Editor, 435
Register Exchange, Calculator, 309
registers, Calculator memory, 308
release (mouse button), definition, 9
remainder, 307
Remote Copy pop-up window, 85
Remote Copy, File Manager, 60
Remove, 137
Remove Brackets, Text Editor, 137
removing links, 96
renaming files, File Manager, 77
repeat appointments, 236
Repeat field, Calendar Manager, 234
Replace text, Text Editor, 135
Reply, Mail Tool, 155
Reply-To header, Mail Tool, 206
resizing windows manually, 26
Retrieve Every, Mail Tool, 198
Return-Receipt-To header, Mail Tool, 206
Rev (reverse) button, Audio Tool, 362
Root, 63
rotating an image

Image Tool, 410

S

Sample Time, Performance Meter, 335
Save Changes, 153

Save Changes, Mail Tool, 185

Save Workspace utility, 511

saving
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Audio Tool files, 353, 369
Image Tool files, 401
Mail Tool changes, 185
text file, 138
SCI (scientific display notation),
Calculator, 304
scientific functions, 320
screen
blank, 555
how to lock, 511
how to unlock, 511
scrollbar
and pointer movement, 495
elements of, 16
modifying location, 501
Scrolling submenu, Command Tool, 284
searching
in the Navigator, 523
SELECT, xxxi
Select All, File Manager files, 62
Select Line at Number, Text Editor, 130
SELECT mouse button, 8
selecting
message header, 152
Sending Messages, 186
Shared Entries, Binder, 454
Shell Tool, 287
base window, 287
Disable Page Mode, 289
Enable Page Mode, 288
icon, 287
stop sign pointer, 289
term pane menu, 288
Shift Lines, Text Editor, 137
shift right, 320
Show “To recipient”, Mail Tool, 199
Show All Subfolders, File Manager, 64
Show Attachment List, 206
Show Attachment List, Mail Tool, 206
Show Caret at Top, Text Editor, 130
Show collisions, Performance Meter, 332
Show context, Performance Meter, 332
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Show cpu, Performance Meter, 331
Show disk, Performance Meter, 332
Show errors, Performance Meter, 332
Show Errs, Tape Tool, 393
Show interrupts, Performance Meter, 332
Show load, Performance Meter, 332
Show packets, Performance Meter, 331
Show page, Performance Meter, 331
Show swap, Performance Meter, 331
Signal With, Mail Tool, 198
Silence detection, Audio Tool, 376
Silence threshold, Audio Tool, 376
Sin Calculator key, 321
SIN, sine function, Calculator, 321
size of windows, modifying, 26
SIn Calculator key, 317
Snap Type, 422
Snapshot, 422
base window, 422
capturing screen pointer, 423
creating a snapshot, 423
Hide Window During Capture, 423
icon, 422
Snap Delay, 423
snapping a region, 424
snapping the screen, 425
snapping window, 423
timer, 423
troubleshooting, 552
types, 422
viewing, 426
Sort By, Mail Tool, 154
sorting
mail files, 193
splitting panes, 142
splitting text panes, 142
Sqrt Calculator key, 307
square root, 307
Square, Icon Editor, 432
* wildcard search, 88
Start field, Calendar Manager, 232
starting



an application, 11,34
starting applications, 35
starting the vacation notifier, 171

status messages
Image Tool, 416

status, print queue, 342

Sto Calculator key, 309

stop (Play) button, Audio Tool, 362
stop (Rec) button, Audio Tool, 363
stop sign pointer, Shell Tool, 289
stopping the vacation notifier, 171
stopwatch, 298

Store log as new file, 283

Store log, Command Tool, 283
Store, Calculator, 309
straight-line depreciation, 317
Strip Path, Tape Tool, 385,394
subfolders, File Manager, 69
Subject field of mail header, 161
submenu, 11

sum-of-the-years’-digits depreciation, 318

Suppress, Tape Tool, 394

Syd Calculator key, 318

Sym Links, Tape Tool, 393
symbolic links, Tape Tool, 393

T

Tag Mask, 466

Tag Offset, 465

Tag Type, 466

Tag Value, 466

Tan Calculator key, 321

TAN, tangent function, Calculator, 321

Tape Tool
introduction, 383
adding a file to write, 385
base window, 384
copying files onto tape, 388
destination, 385
drag and drop, 384

Index

drag and drop from File
Manager, 388
extracting files from tape, 390
File to Write button, 385
Host Name, 393
icon, 383
list files, 384
editing, 385
properties, 385,392
read files, 384, 387
Read menu, 387
reading files from tape, 387
Strip Path option, 385
tape device, 393
troubleshooting, 553
Write settings, 393
writing files to tape, 384, 388
tar command, 383
teletype (tty) interface, 287
Temp file directory, Audio Tool, 376
templates, 169
Calendar template, 277
creating, 169, 213
properties, 213
using, 169, 213
Templates submenu, Mail Tool, 169
10/~x Calculator key, 321
Term Calculator key, 319
terminal emulator pane, 288
Text
Find and Replace, 133
text
adding and deleting, 139
copying, 140
cutting and pasting, 141
text editing panes, 156
Text Editor, 127
introduction, 36
base window, 128
Change Line Wrap, 131
Clip Lines, 132
control area, 128
creating a text file, 137
customizing, 145
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drag and drop, 141, 143 tree, File Manager, 69
editing a text file, 139 Trig Calculator key, 320

emptying document, 130 trigonometric base, 320
File menu, 129

. o f . )
Find and Replace window, 133 trigonometric functions, 320

Find Marked Text, 135 troubleshooting
Find Selection, 134 Calculator, 540
4 Clock, 546

icon, 127
Include File menu item, 129
loading a text file, 138
menus

Edit menu, 133

Extras menu, 136

Find menu, 133

View menu, 130

Command Tool, 290
File Manager, 547
Mail Tool, 549

Print Tool, 552
Snapshot, 552

Tape Tool, 553

truncate calculations, 320

printing files, 141 tty interface, 287
Select Line at Number, 130 type styles, customizing, 485
shifting lines, 137
Show Caret at Top, 130 U
splitting panes, 142
text umask, Tape Tool, 394
capitalizing, 136 undeleting
creating, 129 messages, 154,172
finding, 135 Undo
format, 136 Icon Editor, 445
inserting brackets, 137 Undo, Edit menu, 133

removing brackets, 137
replacing, 135

text pane, 128

What Line Number?, 130 user name, 2

text pane, 128 username.lock, 550
Text, creating in Icon Editor, 432 using

. local aliases, 217
teﬁé terminal emulator pane, 282 templates, 169,213

unlocking your screen, 511
user defined functions, Calculator, 309

.text_extras_menu file, 145

.textswrc file, 147 \4
time zone vacation notifier, 170
Calendar Manager, 258 starting, 171

stopping, 171

timezone, on clock display, 296
Vacation, Mail Tool, 155

To field in mail header, 161

ToDo list Value, calculator function, 312
Calendar Manager, 229 /var/spool/mail file, 550
transfer files, File Manager, 86 vi editor, 37

transferring files, File Manager, 55 View Filter Pattern, File Manager, 116
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View menu
Binder, 454
File Manager, 61
Icon Editor, 443
Mail Tool, 154
Text Editor, 130
view menu
Image Tool, 418
View Message window, Mail Tool, 158
Viewer
closing, 518
customizing, 535
functions, 517
icon, 518
links, 522
Magnify button, 535
printing a document, 536
quitting, 518
viewing
mail, 156
snapshots, 426
viewing mail
multiple messages, 159
next message, 158
previous message, 158
with full header, 158
Voice button, Mail Tool, 161
voice mail
listening to, 358
sending, 356

W

Wastebasket, 22, 92

creating new, 94
.wastebasket, 93
week view

printing, 273
week view, Calendar Manager, 227
What field in Calendar Manager, 233
What Line Number?, Text Editor, 130
wildcard search, 88
window, 6

introduction, 5

Index

base, 29
buttons, 17

click SELECT before typing (click-to-

type mode), 500
closing and quitting, 27
fixing display, 556
menu, 12
move pointer to type, 500
moving front or back, 24
pane, 13
prompt, 16
repositioning, 23
resizing manually, 26
snapshots, 423
window controls, 15
Window Controls utility, 509
windows, xxx
Workspace
definition, 5
how to save setup, 511
menu
how to display, 10
Properties, 478
icon locations, 501
menu drag distance, 496
Workspace menu, 35
world
change file permissions, File
Manager, 99
world Calendar Manager
permissions, 265
wrap
change line wrap, 131
character, 131
clip lines, 132
word, 132
Write settings, Tape Tool, 393
writing files to tape, 384, 388

X

X bitmap, 442, 446
x! Calculator key, 321
x/2 Calculator key, 307
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.Xdefaults file, 145, 322
Xnor Calculator key, 320
XNOR, logical, 320

Xor Calculator key, 320
XOR, logical, 320

Xview icon, 442, 446

Y

y”x Calculator key, 321
year view
printing, 275
year view, Calendar Manager, 229

Z

zooming an image
Image Tool, 411
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